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New Hermes
GravoStyle‘98 Tutorial

Introduction

This tutorial presents a series of  lessons for each level of GravoStyle’98. The lessons are
designed to be followed in order. While there is necessarily some redundancy, we try not to bore
the reader by laboriously repeating the details. Where appropriate, you are directed to the page(s)
containing information previously covered.

This tutorial is not intended to detail all the features of GravoStyle’98. Nor is it a comprehensive
representation of those features discussed. For complete coverage of each command, refer to the
separate GravoStyle’98 User Manual. For instructional purposes, the applications presented in
this tutorial may be more complex than real world applications.

When laying out a job, the designer has the ability to use either artistic or technical methods, or a
combination of both. Artistically, the user can create and manipulate objects and text interactively.
If more precise layout is required, the whole job can be created through precision dialog boxes.
This tutorial helps to introduce and familiarize the user with both aspects of the software.

Each lesson is a guided tour through creating a particular job. The jobs have been selected to
provide an introduction to most of the features of the software. In each, you will find a brief
introduction to the scope of the job, a list of learning objectives naming specific features you will
by using, and the job specifications. Then, the job is explained step-by-step. Finally, there is a
brief summary of the steps as a quick-reference guide.
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Plate Composition
Automatic Mode

Manual Mode

Text in Arc

Vertical Text

Angle Text

Matrix

Columns

Digitizing Functions
Basic Shape Library

Moving, re-shaping Functions

Drilling Point Library

Help Functions
Grid / Guide Lines

Layer / Color

WYSIWYRE

Spell Check Access

Import / Export

Import HPGL-BMP-TIFF-EPS-DFX-IGES-ISO

Export DFX - HPGL - EPS

Laser Drivers

Options
Long Plate

Scanning / Vectorizing

Filling and 2D Tool Management

Braille

Drivers for competing tables

Dials and Rules

Single & multi-line engraver’s fonts

PhotoStyle (engraving a photo)
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Lesson #1 — Beginner Plate Design with Simple Engrave

This exercise will show you how to set up a very simple one-line job in automatic
composition mode. Then, it will take you through the process of preparing it for engraving.
Soup to nuts, at the most basic level

Objectives
Use automatic mode
Set plate dimensions 
Enter text
Change character height

Design Specifications
Filename: 

beginner plate.vnd
Plate size: 3” by 2” 
1st Line Arial, 0.3”       

character height

Creating the Design

We will use automatic mode to enter text. The text will use the default center
justification and Arial font. The character height is the only text attribute used and it
will be applied after text entry. 

Step 1:  Open a new file and set material dimensions 

To open a new file, click on menu File > New

You will be asked for the plate dimensions. 

The width text box will be selected by default (the
selected text has a blue background). Just type the
width (3) and the selected text will be replaced.

Press Tab to move to the next field.

The height text will be selected. Type the height
(2).

Ignore the thickness parameter. 

Click OK to accept

You now see a rectangle representing the plate area. The dashed lines inside the plate
are the margins which are automatically defined by default. 

Open a New File

Ctl-N

Click the New File
Icon in the Main
Toolbar

Alt-F; N
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Lesson #1 — Beginner Plate Design with Simple Engrave

Step 2: Enter The Text 
Just start typing “GravoStyle ‘98”. It will be automatically center justified in the vertical
center of the plate. Notice that the text position and character spacing are
automatically adjusted to fit the text inside the margins. We are working in the
Automatic Mode. In another lesson, we will be working in Manual Mode.

Step 3:  Change The Character Height
Select the text line by clicking and dragging the cursor through the text. You can start
at either end. The selected text will turn red.
To edit the text height value, click in the text height box on the Text Toolbar or hit

F12.

Edit the field to read “.3”, then press Enter to apply the change.

Step 4:  Setup Job for Machining

Click on the Machining icon in the main toolbar.

Make the machining dialog on your screen match the one displayed here. We will not
go into a detailed explanation of this dialog in this exercise. This dialog is discussed in
detail in the Tool Management exercise (Lesson #6).

This default machine is displayed at the top. If you do not see your machine name, try
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clicking on the down arrow to the right of the box. If you see your machine on the list,
select it now. Otherwise, select any machine for this exercise but don’t actually
engrave anything. To add a machine later, see Page 2-5 Installation.

Click the vise icon on the left if using a vise or click the icon above it if using flat plate.
Click the XY dial twice so that the little red indicator is at the far right of the dial. This
is the fastest XY speed setting. Do the same for the Z dial.

This job assumes you are using a single tool, Tool 0. It also assumes you have set up
your tool in the engraver and adjusted the Z-Reference. Also, you must adjust the
depth with a nose cone. Refer to the machine manual for these procedures.

When the tool has been adjusted and the machine is ‘Ready To Receive’, click on the
Run button to send the job to the engraver.

Step 5: Save Your Work!

Ctl-S to save, or use either of the other options at right.

Saving Your Work

Select File from the
Main Menu, then
click  Save from
the Pull-down list.

Alt-F , S

Ctl-S
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Beginner  Plate Design Summary

Step 1: Open a new file and set material dimensions

Set the plate dimensions  to 3” by 2” with automatic borders.

Step 2: Enter the text

Type: “GravoStyle ‘98”. Hit Enter to apply.

Step 3: Change the Character Height

Hit F12 to highlight the character height text box and enter  “0.3”.

Step 4: Setup Job for Machining

Click on the Machining icon . 

Click vise or flat plate. 

Click on speed dials to set speed.

Setup engraver with a tool.

Adjust Z-ref on machine.

When machine is ‘Ready To Receive’, click on Run.

Step 5: Save your work!
Use any of the methods described on Page 4-9 to Save.

Lesson #1 — Beginner Plate Design with Simple Engrave
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NOTES:
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Lesson #2 — Simple Plate

This exercise will introduce you to the many ways to set character attributes. The simple
plate shown here uses three different fonts, underlining, italics and superscript. 

Learning Objectives
Use underlining
Use Undo/redo
Use italics
Use superscript
Adjust margins

Design Specifications
Filename: Simple Plate.vnd
Plate size: 6” by 2” 
1st Line: Futura 3L, 0.5” char height
2nd Line: US Block 1L, Times 8L, 0.4” char height

Creating the Design

By default, when you open a job you are in Automatic Composition mode. This mode
makes it simple to set up a job by providing default margins, automatic line spacing
and justification. 

Step 1: Open a new file and set material dimensions
Open a new file (if you’ve forgotten how, flip back to Page
4–7); the material dimensions dialog box appears asking for
the dimensions of the plate.

By default, the width text field will be selected. Type “6”,
then Tab to the next field.

The height text will be selected. Type  “2”.

Ignore the thickness parameter. 

Click OK  (or Enter) to accept.
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You now see a rectangle representing the plate area. The dashed lines inside the plate
are the margins which are automatically defined by default. 

Note: Both the plate size and margins can be manually changed after plate definition by
choosing Modify>Material. 

Note: the default plate size is the size of the engraving area. This default can be changed in
the Material Tab of the Options dialog (F10). This is discussed more fully in the options
discussion.

Step 2: Enter the Job Text

Click on the Center Justify icon if not already selected. Now, just start typing
“Gravostyle ‘98”.

Hit Enter or click anywhere on the white graphics editing screen.

Type “A cut above the rest!” on the second line.

The text position, line spacing and character spacing are automatically adjusted to fit
the text inside the margins. We are working in the Automatic Mode. In another lesson,
we will be working in Manual Mode.

Oops! We need to capitalize the “s” in “GravoStyle”. 

Select just the “s”.

Type an uppercase S to replace selected text.

Step 3: Change the Character Height

Select the first text line by clicking and dragging the cursor through the text. You can
start at either end. The selected text will turn red.

To edit the text height value, click in the text height box on the Text Toolbar.

Edit the text height value to “.5”. Now, select the second line of text, and edit the field
to read “.4”.

Press Enter to apply the change.

Step 4: Change the Font

Select the first text line by clicking and dragging the cursor through the text. Change
the font to FUTURA 3L. 

Click anywhere in the font selection box and scroll through the pull-down menu.
Notice that a representation of the text is to the right of the font name. 

Click on the Gravograph folder in the font list to access a font in the specific font
library. Select FUTURA 3L.
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Lesson #2 — Simple Plate

Step 4: Change the Font (cont’d)

Hit Enter or click anywhere in the design to apply the changes.

Select the second line of text and change the font to US BLOCK 1L.

Hit Enter or click anywhere in the design to apply the change

Now, we will mix fonts on a line.

Select just the word “cut” and change the font to TIMES 8L.

Hit Enter or click anywhere in the design to apply the change.

This is how the job looks so far.

Step 5:  Underline Text

Select the first line of text, “GravoStyle ‘98”,  if not already selected.

Click on the underline icon on the Text Toolbar.

Press Enter or click anywhere in the design to apply the change.

To change the position of the underline, open the Yellow Pinwheel to expose the line
editing functions.

Single words
can be quickly
selected by
double-clicking
the word.
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First, open the pinwheel by clicking on the pinwheel icon on the left
of the Text Toolbar. Click on the Yellow quadrant inside the Pinwheel.
Now you see the Line Attributes toolbar on the bottom of the screen.

The first line of text should still be selected.

Click in the Underline Position text box and change the text to –20.

Press Enter or click anywhere in the design to apply the change.

The underline just shifted upward slightly.

Click the Undo icon to cancel the last operation.

Click the Redo icon to repeat the last operation.

By alternately clicking these icons, you can better see the effect of  the Underline
Position operation.

Select just the letter “y”. Click on the underline icon to turn off underlining for this
letter. Note that the underline feature is not a toggle. All selected text will either be
underlined or not depending on the state of the this icon regardless of the previous
underline status.

Step 6: Apply Italics
Select the second text line, “A cut above the rest”,  if not already selected.

Tech Notes: Undo/Redo

You can also choose Undo
and Redo from the Main
Menu:

Notice that there is a description of
what you are about to Undo or Redo. 

GravoStyle ‘98 also allows you to set
the maximum number of redo’s
stored in memory. See Options (F10)

Ctl-Z to Undo

Ctl-A to Redo 

Tech Note: Fine tuning your italics

The default value of slant degree is 15. You can change this by clicking in the in
the Green quadrant of the Pinwheel.

A negative value will slant the text to the left.
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Lesson #2 — Simple Plate

Step 6: Apply Italics (cont’d)

Click on the Italic icon  on the right side of the Text Toolbar .

Hit Enter or click anywhere in the design to apply the change.

Step 7: Superscript Text
Select just the word ‘above’. Remember, you  can double-click it for fast selection.

Click on the superscript icon in the Text Toolbar .

Hit Enter or click anywhere in the
design to apply the change.

Step 8: Adjust Margins
Let’s increase the left and right
margins slightly.

Click on the Material Definition icon

. 

On the Material Dialog box uncheck 

Tech Note: Fine tuning your superscript text

The offset amount from the baseline can be adjusted by clicking on the yellow
quadrant on the Pinwheel.

Any selected text can be adjusted above or below the baseline by the desired
percentage with this text tool. The percentage from the baseline figure is relative to
the character size. When using the superscript icon, the selected text is
automatically reduced 50% and raised 100% above the baseline.

Tech Note: Line length compression

In automatic mode, compression is automatic. You can view the compression ratio
on the Text Toolbar

When there is no compression, the value is zero. When the text line can no longer
fit between the margins, this value goes negative. Both the character width and
intercharacter spacing are automatically adjusted. You can further manually modify
character width and intercharacter spacing.
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Step 8: Adjust Margins (cont’d)
the “Margins auto-correction” checkbox so we can manually determine the margins.

Edit both the Left and Right margin text box values to “.3”.

Click OK (or Enter).

Notice that the second line of text expanded to fill the space between the left and
right margins. This second line had been too large for 

the space and so was automatically compressed. By increasing the 

margins, the compression was reduced.

The line length can be reduced to exactly fit a line of text into a precise width. This
can result in text compression. 

For example: Click anywhere on the first text line and edit the Line Length value to
“3”, then Enter. A new compression ratio of -39.50 for this line has been automatically
set.

Notice that all the text on the line now fits the shortened baseline by reducing the
character width and intercharacter spacing. 

Step 9: Save your work!

Tech Note: Paragraph level compression

Another compression feature forces all selected lines to be compressed to the maximum
ratio of any one line in the selection. This will make the characters appear more uniform
and more visually pleasing. 

To see this in action:

Click anywhere in the first line and drag to anywhere in the second line.

Click on the Compression by Paragraph icon . Hit Enter to apply.

Now click on any baseline and you will see that the same compression ratio has been
applied to all selected lines.
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Simple Plate Design Summary

Step 1: Open a new file and set material dimensions 

Open a new file . Set the plate dimensions to 6” L x 2”W, with  automatic borders.

Step 2: Enter the Job Text

Add text to the first line: “GravoStyle ‘98” 

Hit Enter and add text to the second line “A cut above the rest!”.

Step 3: Change the Character Height
Select all the text on the first line and change the character height to 0.5”.

Select all the text on the second line and change the character height to 0.4”.

Step 4: Change the Font

Select all the text on the first line. Go to the font pull-down menu

and select the FUTURA 3L font 

Select the second line of text. Change the font to US BLOCK 1L.

Step 5: Underline Text
Select the first line of text. Click on the underline icon on the Text Toolbar to
underline the first line. Apply.

Open the Yellow Pinwheel by clicking on the icon. Click on the Yellow quadrant

inside the Pinwheel. Edit the Underline Position text box and change the
text to –20. Apply.

Select the letter “y” on the first line and turn off underlining by clicking the underline

icon to its off (out) position.

Step 6: Apply Italics
Select the second text line if not already selected. Click on the Italic icon .  

Step 7: Superscript Text
Select the word “above” on the second line and click on the superscript icon .

Step 8: Adjust Margins
Click the Material Definitions icon and set left and right margins to .3”. 

Click anywhere on the first text line Adjust the Line Length value to 3”. Apply.

Step 9: Save your work!

Lesson #2 — Simple Plate
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NOTES:



In this lesson we will create a simple plaque consisting of eight lines of text, one of which is
on an arc. We will also learn how to easily create mounting holes.

Learning Objectives
Modify Line Spacing
Working With Text On An Arc
Align Job In Center Of Plaque
Add mounting holes

Design Specifications
Filename: Simple Plaque.vnd
Plate size: 6” by 8” 
1st Line: CLARENDON 6L, 0.4” char height, 4” arc chord, 1” arc height
2nd Line: FUTURA 3L, 0.25” char height
3rd Line: SCRIPT 2L, 0.35” char height
4th Line: FUTURA 3L, 0.25” char height
5th Line: FUTURA 3L, 0.25” char height
6th Line: FUTURA 3L, 0.25” char height
7th Line: FUTURA 3L, 0.25” char height
8th Line: FUTURA 3L, 0.25” char height
Lines  3 & 4: 150% Proportional Line Spacing
Lines  7 & 8: 150% Proportional Line Spacing

Creating the Design

Plaques are easily created in Automatic Composition mode. They usually have more
text lines than either the Name Badge or the Simple Plate designs. As you have already
learned, you can enter some text or all the text, and format it after input. In this
exercise you will see that text attributes can be specified before entry.

Step 1: Open a new file and set material dimensions
Use one of the several ways to open a new file as described on Page 2.

In the Material Dialog Box, enter dimensions of 6”W x 8”L.

Step 2: Enter the Text

Click the Center Justify icon if not already selected. Change the text size to .25. 

Select FUTURA 3L under "Gravograph fonts"  in the font pull-down menu. Remember
to Enter to apply the change.

Note: If the Gravograph fonts list is already opened, clicking on the heading will close
the list. 

Lesson #3 — Simple Plaque

4-20

New Hermes GravoStyle’98 Tutorial



4-21

New Hermes GravoStyle’98 Tutorial

Step 2: Enter the Text (cont’d)
Press the Caps Lock key for all upper case text entry. Type  "AWARD OF
MERIT", then Enter. Text placement is automatically centered. The cursor
is now on the second line.

Press the Caps Lock key again to turn off upper case text.

Continue typing the following lines of text, hitting Enter after each line
except the last:

“Presented To”
“David Daffner”
“In Appreciation”
“For Your Standard Of Excellence”
“Loyalty And Friendship”
“NEW HERMES INC.”
“1998”

All lines are now center justified in the center of the
plaque (see figure at left)

Step 3: Modify Text Attributes

Now, to enhance the appearance of the plaque, we’ll
apply different attributes to some of the lines.

Select the text  "AWARD OF MERIT". Change font to
CLARENDON 6L and the character height to .4. Hit
Enter to apply these changes. 

Select the text, “David Daffner”.

Change character height to .35 and change the font
to SCRIPT 2L. Remember to Enter or the changes
won’t be permanent.

Your plaque now looks  like the picture at right.

Step 4: Modify Line Spacing
(see Tech Note page 25)

The text has been modified, but the line spacing needs
to be adjusted to set the recipient’s name  apart from
the rest of the text.

Click anywhere on the line containing the words "David Daffner" and drag the red text
cursor to any position on the following line, “In Appreciation”. We just need to include
the two baselines. Open the Yellow Pinwheel. If not already open, click on the

Pinwheel icon . Then select the yellow vane of the Rapid Choice Pinwheel located
in the lower left corner of the screen.

F12 selects the
text height field in
the text toolbar.

Tech Note: Text Editing

To navigate  through text, via the
keyboard, use:

• Up & down arrows to move
vertically.

• Left or right arrows to move by
letter.

• Home and end, respectively, to
move to the beginning or end
of the line.

• Ctl Home or Ctl End,
respectively, to move to the
first or last character in  the
composition.

When selecting text, keep the cursor
inside the baselines. In all other
respects,  selecting text is similar to
methods used in most Windows text
editors. For more specific
information, see the GravoStyle ‘98
User Manual.
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Lesson #3 — Simple Plaque

Step 4: Modify Line Spacing (cont’d)

Click on the Proportional Line Spacing Icon 
and enter 150. Hit Enter to apply.

We just doubled the amount of line spacing around
the line “David Daffner”.

Repeat this line spacing for the line “New Hermes”.
Select any portion of the two lines starting with “New
Hermes”. Click on the Proportional Line Spacing Icon
and enter 150. Hit Enter to apply.

Step 5: Working With Text On An Arc

Click anywhere on the first line.

Click on blue vane of pinwheel.

Click on Text on Arc icon . A dialog is
presented informing you that you are about
to enter Manual Composition Mode. Once
you start working in this mode, you will be
unable to return to Automatic Composition mode for the remainder of the job.

Click the Yes command
button to accept.

The Arc Text dialog is
displayed next. This dialog
give you two ways to define
the arc dimensions and four
ways to put text on the arc.

Hit Tab to put the focus on
the Length Of The Arc
Chord field. Enter 4. This
will leave 1 inch on either
side of the plaque.

Hit Tab. Enter 1 for the Arc
Height.  Hit Tab. This sets
the arc curvature which

Tech Note: Viewing your work

Zoom in to a closer view by
positioning the cursor over the
center of the text line, then
pressing the right mouse button.

Zoom out to a wider view by
holding the Ctl key and clicking
on the right mouse button.
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can be previewed in the lower left box of the dialog. 

Notice that the arc angle and radius are automatically calculated
based on the previous two values entered. Alternatively, you
could have entered the radius and angles if it would make more
sense in your particular design.

The default arc selection was text above a raised arc which can
be changed on the right side of the dialog. Click Ok to accept.
The arc text parameters for an arc text object may be modified at
any time by clicking the Arc Text icon while the text cursor is on
the arc baseline. 

Note that the arced text is partially off the material. This is due to
the Y-coordinate value having been automatically set to the
selected text baseline's Y-coordinate. We could have edited this
value in the Arc Text Dialog but it will be easier to reposition this
object visually.

Click on the Select icon to exit text mode.

Click and drag on any part of the
text inside the material. A rectangular outline of the
object is shown. Drop the object when in position.

Now, let’s increase the arc angle of the text to make it
look more balanced. Since we are still in Select Mode,
just double-click on the arc text to select it and enter
text mode in one step. 

Click on the Arc Text icon to bring up the Arc dialog.
The arc chordal length should still be 4 and the arc
height should be 1. Change both the left (start) and
right (end) angles to 65˚ from 53.13.

Click on the green vane of the Pinwheel. Change the

intercharacter spacing value to 110%. Now,
doesn’t that look better? (See figure at left.)

Step 6: Aligning the Job in the Center of the Plaque

There are a number of methods for aligning objects. In the Industry and more
advanced levels of GravoStyle ’98, special Alignment tools are available. In this lesson,
we will use the guidelines to approximate centering the job in the material.

Click on the top ruler and drag and drop a horizontal guideline near the center of  the 

plaque. Double-click on this guideline to bring up the guideline editor. 

Tech Notes:  Moving Objects

To constrain the movement to a single
dimension (either horizontal or vertical)
hold the Control key while dragging. 

Hit F4 to preview the object while
dragging. 

Use the keyboard arrow direction keys to
nudge (incrementally move) the selected
object in any of four directions.

Set the arrow key nudge amount: In the
main menu click Edit, then Options or hit
F10 to open the Options Dialog Box.

Change arrow move value to “.1” (or any
value you prefer). Click OK.
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Lesson #3 — Simple Plaque

Step 6 Aligning the job in the Center of the Plaque (cont’d)

Type “4”  (half the total material length) into the position text box. 

Other dialog boxes expect you to hit OK to apply changes. Here you must remember
to click Change to fix the location of the guideline. When you click Change, the
dialog box disappears.

Click on the left ruler and drag and drop a vertical guideline near the center of the
plaque.

Double-click on this guideline to again bring up the guideline editor. Type “3” (half the
total material width) into the position text box. Click Change to fix the location of this
guideline.

The intersection of the guidelines indicates the exact
center of the plate.

Click on the Edit menu and Select All. 

Click-drag the selection to the center of the material.
As best you can, align the dotted  box outline to fit
inside the solid border of the material. Make the
vertical sides of the selection equidistant from the
vertical sides of the material and the horizontal sides
of the selection equidistant from the horizontal sides
of the border.

Use the arrow keys to align the selection’s vertical
and horizontal midpoint control handles with the
guidelines.  (See figure at right.)

In Select Mode,
Ctl-L to select all
the objects
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Step 7: Add mounting holes

Click Drill icon on the shapes toolbar to bring up the Drill Hole Dialog Box

Change hole depth to “.25”.

Hit Tab. Change drill diameter to
“.125”.

Click on the 4 corner holes icon.

Enter “.5” for distance from corners in
each text box

Click OK.

Step 8: Save your work!
Use one of several ways to Save shown
on page 4-9.

Tech Note: Line Spacing

There are three modes of spacing for lines; fixed, proportional and typographic. The
distance between two adjacent baselines is determined by adding the text height and
this line spacing. 

Proportional Line Spacing  

This is the default line spacing mode for a new job. The
default spacing ratio is 75%. This means that the line
space between the top of the ascending letters and the
preceding base line is 75% of the character height. At a
value of 0%, the tops of the ascenders touch the previous
baseline as shown.

Typographic Line Spacing

This spacing mode averages the text height of
two successive lines. It accounts for both
ascenders and descenders in its calculations.
At 0%, the tops of the ascenders just touch the
descenders on the previous line.

The default spacing in this mode is 100%.

Fixed Line Spacing 
With fixed line spacing, a constant value is specified for the
distance between successive baselines. In
these examples, the text height is 1”.

0% Line Spacing 100% Line Spacing

Line Spacing 1”Line Spacing 0”
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Simple Plaque Summary

Step 1: Open a new file and set material dimensions
Set plaque dimensions  to 6” width by 8” height with automatic borders.

Step 2: Enter Text
Click on the Center Justify

Select the FUTURA 3L font from the Gravograph font folder. Enter.

Type "AWARD OF MERIT" and Enter. 

Type the following lines. After each line except the last, Enter.
“Presented To”
“David Daffner”
“In Appreciation”
“For Your Standard Of Excellence”
“Loyalty And Friendship”
“NEW HERMES INC.”
“1998”

Step 3: Modify Text Attributes
Change font for AWARD OF MERIT to CLARENDON 6L with a height of “.4”.

Change David Daffner to 'Script 2L' font with a height of “.35”.

Step 4: Modify Line Spacing
Select the 3rd and 4th lines in the job; click and change
the Proportional Line Spacing to 150%.

Select the 7th and 8th lines in the job and change the Proportional Line Spacing to
150%.

Step 5: Working With Text On An Arc
Select the first line of text. Click on the Text on Arc icon located on the blue vane
of   of the pinwheel. Enter 4” for the chord length and 1”for the arc height.

Step 6: Aligning Job In Center Of Plaque
Select and drag the arc text to position.

Step 7: Adding mounting holes
Click on the Drill icon. Set hole depth to .25” and drill diameter to 0.125”. Choose 4
holes with a distance of .5” from the corners.

Step 8: Save your work!

Lesson #3 — Simple Plaque
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NOTES:
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Lesson #4 —  Name Badge

This exercise introduces the basic features of the Discovery Level software that you will be
using in many of your designs. The name badge you will create consists of  two lines of
text, an imported logo and a symbol from the symbol library. 

Learning Objectives
Use Automatic Composition Mode
Set dimensions of the material
Set margins
Change character height
Select fonts
Align text
Use symbols
Move and scale objects
Import a graphic

Design Specifications
Plate size: 2” by 1” 
1st Line:” FUTURA 3L, 0.1” char height
2nd Line:” FUTURA 3L, 0.1” char height
Symbol graphic: NHlogo.syb
Graphic: golf.eps
Filename: name badge.vnd

Creating the Design
When beginning a job, the software activates the Automatic Composition mode by
default. This mode makes it simple to set up a job by providing default margins,
automatic line spacing and justification. Adding predefined artwork is very simple.

Step 1: Open a new file

To open a new file, click on File in the uppermost menu bar on your screen. Then,
click on New in the roll-down menu below it.
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Step 2: Set material dimensions
A Material dialog box appears asking for the job dimensions.

The width text box will be selected by
default (the selected text has a blue
background). Just type the width (2)
and the selected text will be replaced.

Press Tab to move to the next field.
The height text field will be selected.
Type the height (1).

Uncheck the “Margins auto-correction”
checkbox

Edit the Left margin value to 1

Edit the Right margin value to .05

Ignore the thickness parameter. 

Click OK to accept

You now see a rectangle representing
the plate area. The dashed lines inside
the plate are the margins.

Note: Both the material size and margins

can be changed after defining dimensions: In the Main Toolbar, click the icon or in
the menu bar, click Modify, then click Material in the pull-down menu. 

Note: The default plate size is the size of the table engraving area. This default can be changed
in the Material Tab of the Options dialog (F10). 

Step 3: Enter and Format the Job Text
The default cursor position is centered between the margins. Now just start typing
“John Norris”.

We will now change a few text parameters for this line before applying these changes
to the design. This will speed the design process since we will not have to wait for a
screen refresh for each separate change.

Select all the text on the line by dragging the cursor through the letters. You can drag
left-to-right or right-to-left. The selected text will turn red. 

Click the Left Justify icon 

When a dialog
command button
[OK] has a black
outline, it is the
default. Hitting
Enter has the
same effect as
clicking on the
default button.
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Step 3: Enter and Format the Job Text  (cont’d)

To edit the text height value, click in the text height box on the Text Toolbar.

Edit the field to read “.15”

Click anywhere in the font selection box and scroll through the pull-down menu.
Notice that a representation of the text is to the right of the font name. 

Click on the Gravograph folder in the font list to access a font in the specific font
library. Select FUTURA 3L.

Hit Enter or click anywhere in the design to apply the changes.

This is how the job looks so far:

Now, we will add a second line of text; Hit Enter.

Type in the word “President”.

Notice that all previously set text attributes are still in effect

There are three
ways to scroll. 

1. Click on a font name and
drag up or down through the
list. Releasing the mouse
button finishes the selection
of the highlighted name.

2. Or you can use the scroll
bar on the right side of the
pull-down menu to navigate
through the list. You must
then click on a name to finish
the selection

3. Or you can press one or
more letters corresponding to
the first letter(s) of the font
name to quickly jump to the
first font name beginning
with the letter(s). For this to
work, though, you must
highlight any font name
before typing. 

F12
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This is how the job has progressed.

Step 4: Using the Symbol Library

Exit text mode by clicking on the Select icon in the toolbox on
the left.

Click on the Symbol Library icon on the shape toolbar on the
top of the screen.

The Symbols Library Dialog Box appears

Click on plus signs in left library hierarchy widow to reach the desired library, then
click on the library to view the symbols contained in that library

Click on symbol to select and click OK.

Shortcut: You now have a dashed box representing the symbol ready for placement

Position the box and click to place.

Double-click the
symbol to Select
and Enter in one
step.

Tech Note: Adding a Symbol to the Symbol
Library

Import a logo from the floppy and save it as a
symbol in the GravoStyle ’98 symbol library.
Starting in Select mode, go to the main menu; click
File > Import. Navigate to the a: drive and choose
files of type HPGL.

Double-click the filename to import the logo. While
still selected (red), export the logo to the symbol
library. From the main menu click File > Export.
Navigate to c:\GravoStyle98\Symbols. Click Create
New Folder icon and type “MySymbols”. Change
directory to “MySymbols”. Type the filename,
“NHLogo.syb” and save as type Symbol (.syb).
Enter or click Save.

2
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Step 5: Moving and Re-Sizing
Notice that the symbol is too large for the plate, so its size needs to be reduced.

Click the Lock icon on the bottom status line to toggle locking off 

When the Lock icon is on, the cursor may only move freely inside the material
margins. 

To view the entire design, click the Zoom max icon 

Click over any line in the symbol to select the graphic object (it turns red).

Now resize the symbol by dragging any corner handle toward its center. As the symbol
is being resized, you see a dashed line representing the symbol size. Release the mouse
button when the object is at the desired size within the margins. 

Click on the Zoom To Material icon to get a closer view.

Click and drag the corner handle of the object once again. Before releasing the mouse
button, press the F2 key. This brings up a scaling dialog:

Enter a width of .9. Hit the Tab key. Since the proportional check box is on,
the height is calculated automatically.

Click OK (or hit Enter) to accept.

Now we will move the object into a precise position.

Click on the Transformation Tool icon in the Toolbox on the left side of
the screen.

This brings up a floating toolbar of Transformation tools.

Press  F4 to toggle on
and off a preview of the
object while it is being
sized. 

Press  F2 to specify
exact values for when
precise dimensions are
required for scaling or
moving.

Tech Note: Resizing Objects

After selecting, there are several ways to
resize an object or objects:

Proportional Scaling : Click on
any of the four corner handles and
drag in or out 

Symmetrical and Proportional Scaling:
Click on any of the four corner
handles and drag in or out while
holding the Shift key

Incremental Scaling: Start dragging any
handle while holding the Ctl key.  As the
object is stretched, its size increments 100%,
200%, 300%, etc.

Non-Proportional Scaling: Click and drag
any of the four side handles to
stretch one side of  the object
horizontally or vertically.

Non-Proportional Symmetrical Scaling:
Click and drag any of the four
side handles to symmetrically
stretch 2 sides of the object
horizontally or vertically.

100% 200%
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If this toolbar is obscuring your view, click on the caption bar and drag it to another
location.

Click on the Move Icon to initiate a move operation. Now we must indicate the
reference point to start the move.

Hit F3 to bring up the Snap dialog.

Click on the Control point button and click OK. (or hit Enter).

Without clicking a mouse button, hold the cursor over the selected object. As the
cursor hovers near a control point or intersection, you see a small circle. This indicates
where the cursor will snap when the mouse button is clicked. Position the cursor on
the upper left corner of the graphic. 
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Step 5: Moving and Resizing (cont’d)
Click and start dragging. Before releasing the mouse button, press F2 to invoke the
coordinates dialog. This allows you to enter a coordinate for the final position of the
reference point.

Enter .05 into the X box and .95 into the Y box. Since the relative coordinate
checkbox is off, the object’s top left corner will be positioned at absolute X,Y
coordinate position of  0.050, 0.950 as referenced from job zero in the lower left
corner of the material. Click OK (or hit Enter ) to accept.

Step 6: Importing a Graphic

Click on File from the main pull-down menu, then click on Import.

The File Import Dialog Box appears.
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Choose the eps file type by clicking on the arrow to the right of the file type field
and scrolling through the selections.

Browse to the a:\name badge design sub-directory  and select golf.eps

Click Open

View the entire design by clicking the Zoom max icon 

Drag the graphic so that its lower left corner is near the lower left corner of the
material margin. Drag and drop the upper right corner of the graphic, making it
smaller to fit in the blank area of the badge.

Click on the Zoom To Material icon  to get a closer view.

Drag the  graphic to its final position. You can scale and position this by eye.

Step 7: Save your work!

In the Main Toolbar, click the File Save icon or choose one of several Save
shortcuts shown on page 4-9.

When browsing,
double-click the
directory or file to
select and open the
file in one operation.

Nudge a selected
object using the
directional arrows on
the keyboard. Set the
nudge distance in the
options dialog (F10).
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Name Badge Summary

Step 1: Open New File . 

Step 2: Set material dimensions 
Set dimensions to  2” by 1” with a left border of 1” and right border of 0.05”.

Step 3: Enter and format the text 
Type “John Norris” using FUTURA 3L font, left justified with a character height of 0.15.
Go to the end of the first line and hit Return to add a second text line. Type:
“President”.

Step 4: Use the Symbol Library

Import the New Hermes logo (NHLogo.syb) from the Symbol Library .

Step 5: Move and Resize
Resize and place the New Hermes graphic into the upper left corner of the job. Unlock

the cursor to work outside the margins . Use the F2 key to scale the symbol

proportionally so that the width is 0.9”. Using the Move Object tool on the

Transformation Toolbar , place the upper left corner of the symbol precisely at
0.05 in the X and 0.95 in the Y. Snap to control points (F3) to find the exact corner.

Step 6: Import a graphic
Click on File > Import from the main menu. Find the proper subdirectory, select and
open (golf.eps). Resize and place anywhere in the lower left of the job.

Step 7: Save your work!

Save to disk or use any of the other save routines shown on Page 4-9.
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NOTES:
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There are many ways to create signs depending on the design requirements and the level of
software you are using. In the Discovery Level, we will design a sign by combining
individual elements such as text boxes and graphic objects. 

Objectives
Manual Composition mode
Set up job using guidelines
Create and place ellipse and arrow graphical elements
Create and place text boxes
Use Vertical text

Design Specifications
Filename: basic sign.vnd
Material size: 8” W x  6” L
Margins: all 0.3 from edge
Heading: CLARENDON 3L, 0.5” high
Street No: CLARENDON 3L, 0.5” high
Tenants: CLARENDON 3L, 0.3” high
St Address: CLARENDON 3L, 0.2” high
Ellipse: 2.19” x 3”
Rectangle: 5.213” x 3”
Arrow: 4.96” long

Creating the Design
Guidelines are a powerful design tool. In conjunction with the F2 dialog, design
elements can be placed accurately. The designer has many shapes and combinations of
shapes and lines that can be used in an infinite number of ways. Text boxes are like
primitive automatic composition objects.  There are special tools available to place
text on an arc, on a spline, on the vertical and on a diagonal. We will use the vertical
text tool in this job.

Lesson #5 — Basic Sign
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Step 1: Open a new file and set the material dimensions
Open a new file and set the material dimensions to 8” wide by 6” high.  

Step 2: Add Guidelines

Click on the Manual mode icon . Manual mode must be used for text on an arc,
diagonal text and vertical text. In Manual mode, the margins default to 0. Also, each
line of text is independent of the others. 

Invoke the Material definition dialog by clicking on and set all margins to .25”
using the same margins checkbox as shown.

Job zero is, by default, in the lower left corner of the material.

Now, we will set up some guidelines to help place the individual design elements.

Click on the Select tool .

While dragging a guideline from the left ruler, hit F2 to invoke the Precision dialog.

Type 2.5 in the X-coordinate box. This will move the vertical guideline to exactly 2.5”
from the job zero.
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Step 3: Add Guidelines  (cont’d)
Drag a guideline from the top ruler and hit F2. Type 4.5 in the Y-coordinate box.

Drag another guideline from the top ruler and hit F2. Type 1.5 in the Y-coordinate box.

Last, drag another guideline from the top ruler and hit F2. Type “.75” in the
Y-coordinate box.

Here’s what the design should look like now (reference letters excluded).

Step 3: Create and Place Graphical Elements

Click on the Ellipse tool in the shapes toolbar.

Hit F3 for the Snaps dialog and click on the Grid and guide button  . Click OK.

Hover the mouse cursor over intersection A until you see the small red hint circle.
Click once. Move the mouse cursor down and to the right to the guideline intersection
B until you see the red hint circle again. Click once more to place the ellipse.
Alternatively, you can click at the first point, drag to the second point and release. 

Click on the arrow icon on the Shapes toolbar.

Select Orthogonal Arrow and Click OK.

Click at the guideline intersection  C to place the start of the arrow. Drag (stretch) the

A

B

C D
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arrow to the right. Click at D to place the tip of the arrow. 

Drag the cursor up to modify the width of  the arrow head. Drag the cursor to the left
to change the angle of the arrow head. When satisfied with the preview, click to place
the arrow head. Move the cursor up and down to vary the thickness of  the arrow
shaft. Click once more to finish the arrow creation. If the arrow doesn’t live up to your
creative expectations, you can easily undo and start over. An alternate method of
creation is to hit the F2 key after clicking the arrow icon. This presents a dialog where
you can define precise values for all parameters. 

This is how the design looks now:

Step 4: Create And Place Text Elements

Click on the Text icon in the toolbox to enter text mode. Remember, we are in Manual
Composition mode. 

Click on the blue vane of the Pinwheel and click the Text into Rectangle Icon .

Click and drag the text box in top area of the material above  the ellipse. Between E &
F set the character height (F12) to .5 and the font to CLARENDON 3L as shown.

type “PROFESSIONAL BUILDING”.

We will design the street number using vertical text. Click anywhere in the material.

Click on the Vertical text icon  The Vertical text dialog prompts you for the start

E

F
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of the text baseline. It defaults to the center of the material. Click
OK.

Type  “2200”. Now we’ll place this in the center of the ellipse.

Click on the Select tool. Click on the vertical text to select it.

Click to open the transformation toolbar. Click on the move

object tool . Click once in the center of the selected vertical text. When you move
the cursor, the selection moves relative to its center. Now to place it in the center of
the ellipse, hit F3 and select the Gravity center snap. Click OK. Hover the cursor over
any point along the curve of the ellipse. When you see the red hint symbol in the
center of the ellipse, click once to place the selection. You can resize the text, if
desired, by dragging the object’s handles.

Let’s add the address. Click on the text icon to go back to text mode. Click in an
unused area of the design to deselect the street number text. If you neglect this step,
you will put the previously selected text in a text box object. Click on the Text box

tool . Hit F3 and choose Snap to Guideline again. Create the text box in the lower
left corner of the design under the ellipse. Change character height to .2 and type:
“Northmont Pkwy”
“Duluth, GA 30022”

The software automatically compresses each text line and the interline spacing to fit
the box.

Click again in an unused area of the design to deselect the street number text. Click on
the Text box tool. Place the text box below the title and to the right of the ellipse. Set
the character height to “.3”.
Type: “M. Welby, MD”, hit Tab and type “100”, Enter
Type “B. Casey, MD”, hit Tab and type “200”, Enter.
Type “T. Magnum, PI”, hit Tab and type “300”.
The Tab character acts as a separator.

Step 5: Final Tweaking
Click on the Select tool. Select the newly
created text box and the arrow. We will resize
these objects to improve their appearance.
Drag one of the side handles inward while
holding the Shift key for symmetrical scaling
(See Tech Note on Page 4-32). Drop the
selection when it is at the appropriate size.

You can add a rectangle around this text as an
enhancement. Click on the rectangle icon in
the shapes toolbar. Click and drag around the text.

Step 6: Save Your Work!
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Basic Sign Summary

Step 1: Open a New File and Set Material Dimensions
Set sign dimensions to 8” wide by 6” high. 

Step 2: Place guidelines

Change to Manual mode . Invoke the Material definition dialog. Set all margins to

0.25”. Change to Select mode. Click-drag guidelines, then double-click them to
open the Guideline Dialog Box. 

Position the following guidelines: Vertical guideline at 2.5”; Horizontal guidelines at
0.75, 1.5 and 4.5”.

Step 3: Create And Place Graphical Elements

Using the guidelines, place an ellipse in the left center of the material as per the
design graphic image above.

Click the arrow icon , then choose to create and place an orthogonal arrow in the
bottom right section of the material. This is an artistic expression. Try different types,
shapes and sizes of arrows.

Step 4: Create And Place Text Elements

Using the Text in a Rectangle tool , create and place “PROFESSIONAL BUILDING”
along the top of the material in the CLARENDON 3L font at 0.5” character height.

Using the Vertical Text tool ,  type the street number. Position this number in the
center of the ellipse using snaps and resize as required. This is also in the CLARENDON
3L font at 0.5” character height by default.

Again, Using the Text in a Rectangle tool, create and place the address in the lower left
corner of the design as per the finished design graphic.

Add another Text in a Rectangle to the right of the ellipse with the names and suite
numbers of the tenants.

Step 5: Final Tweaking
Resize the tenants text and arrow. Add a rectangle around the tenants.

Step 6: Save Your Work!
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Lesson  #6  — Tool Management by Color

In this exercise, we will learn how to manage jobs with multiple tools. We will learn how to
define and select tools. We will also cover setting the speeds, feeds and depths associated
with each tool. And finally, we will learn how to use the Machining dialog we saw briefly in
the first lesson.

Objectives
Open an existing document
Assign color to objects
Tool color associations
Configure the engraving parameters
Set up the job for machining

Design Specifications
Plate size: 6” by 2” 
1st Line: Futura 3L, 0.5” char height
2nd Line: US Block 1L, Times 8L, 0.4” char height
Filename: Simple Plate.vnd

Creating the Design 

We will not actually create a design in this exercise. We will use the Simple Plate job
created previously.

Step 1: Open An Existing Document

Click the file open icon in the main toolbar or select File > Open on the menu.
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If you do not see the Simple Plate job (Simple plate.vnd) in the displayed directory,
you need to navigate to the directory where the file can be found. Click in the Look in
pull-down menu at the top of the dialog. Use the scroll arrows to choose the directory.
Click on the directory to select. Click on the filename in the list box below and click
Open to bring the selected file into GravoStyle ’98.

Step 2: Color Assignments

The method used to engrave a job with multiple tools is to assign a different color to
each tool much like a pen plotter. If the job uses only
one tool, you can skip this step and use the default
black tool (1).

Open the Machining Tools window by clicking on the

Machining Tools icon in the main toolbox.

We will use two tools in this job, one for the multi-
line font and another for the single line font. Select
the first line of text “GravoStyle ‘98”. Remember that
you must be in text mode to select the text. A quick
way to go into text mode from select mode is to
double-click on the text object.

Now, double-click Tool 2 in the Machining Tools
window to assign Tool 2 to the selected text. Click
anywhere in the white design area to deselect the
text. Notice that the text is now green.

Select the word “cut” on the second
line. 
Shortcut: double click the word to
select. Assign this text to Tool 2 by
double-clicking the green bar.

Repeat this process for the remaining
text assigning it to the blue tool, Tool
3. It’s irrelevant which tool number
you use in this step since we have
yet to associate the real tool with the
Tool number.

New Hermes GravoStyle’98 Tutorial

Double-click the
filename to select
and open in one
operation.

Tech Note: Editing
Machining Tools

Labels

You can rename the
label associated with
the color, but only in
the Machining Tools
window. First, select
the tool. Right click on
the tool label and you
see an edit cursor. Edit
as you wish. Here is an
example:
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Step 3: Tool And Color Association
Click on the Properties button located at the bottom of the Machining Tools window.
This invokes the Tool Property dialog.

On this dialog, you associate specific tools with colors. You set the engraving depth
and the engraving mode; center or fill. The 2D fill is available as standard in Graphic
and Dynamic levels and is available as an option in Discovery and Industry.

Tool and color association

To associate the color and tool, first click on the color and then double-click on the
tool. For this example, click on the blue Tool 3 and double-click on the 030 tool. Then,
click on the green Tool 2 and double-click on the 020 tool. You can verify the
association by first clicking on another color, say on the black Tool 0. Then click on
the blue Tool 3. Notice that a dashed box surrounds the 030 cutter. Click on the green
Tool 2, and the dashed box surrounds the 020 cutter. Currently, this tool and color
association is only remembered with the job. But, in a future release, the association
can be saved as default for new jobs.

The next step is to set the depth. The depth is the distance the tool drills into the
material from the Z reference (Zref) point set at the engraver. You do not associate
depth with the tool. Depth is associated with color. First, click on the green tool color
bar, and enter an engraving depth of 0.01 in depth text box. Next, click on the blue
tool color bar, and enter 0.015 in the depth text box. The depth parameter should set
to zero if you will be setting the depth with the nose cone.

Note: You should use a depth-regulating nose unless the material is prone to
scratching. It does not require a precise Zref adjustment and it provides a
constant engraving depth over material with varying thickness.

Refer to the user’s manual delivered with your New Hermes machine to understand
how the Zref influences the adjustment of the engraving depth and how to carry out
the mechanical adjustment of the engraving depth.



4-48

New Hermes GravoStyle ’98 Tutorial

You can click on the Add/Change tools button to add or edit a cutting tool. See the
Tool Library Tech Note below.

You are allowed to associate one tool with more than one color. This would be useful,
for example, if you set up a job with different colors at different depths (or design
layers) and wanted to use the same tool for multiple depths (or design layers).

Tech Note: Tool Library

Each tool has to be defined in the tool library to get accurate 2D fill and 3D tool path
calculations. For Discovery level without the 2D fill option, only the tip width is important to
get a good representation on the WYSIWYRE screen. Otherwise, this information is useless

for Discovery since the depth in most
jobs is set with the nose cone
micrometer and the engrave depth is set
to zero in the Machining dialog.

For 2D operations using tool color
management, the program is only
interested in the name, shaft diameter,
cutting angle and tip width. For good
results using 2D fill and 3D, the actual
tool must match these parameters
precisely. 

The tool dialog can be invoked two
ways.  The first way is by clicking the
Add/Change tools button from the
Property Sheet dialog. The second way
is from the main pull-down menu;
Machining > Tools data base.

You select the tool from the dialog pull-
down menu. You create a tool by typing
a new Tool name in the pull-down
menu, modifying the parameters and
clicking save.

The Reference and Supplier text box entries are optional and are not used elsewhere in the
program. 

The parameters to modify when creating a tool are:

• Tool type: choose a type of tool from the shape tabs. The software supports
engraving cutters, end mills, ball mills, rounded conical tools and user defined.
For most all jobs not in Dynamic level you will be using engraving and end mill
cutter definitions.

• Shaft diameter: this value is really only useful for calculations made in the
Dynamic level.

• Cutting angle: this is half the included angle.

• Tip width: this is the actual tip diameter. The tip width of all New Hermes and
Gravograph tools is defined as the width 0.008” above the tip.

Lesson #6 — Tool Management by Color 
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Step 4: Machining; or Pass Table
On this same dialog, click the Machining tab. This will allow you to set engraving
parameters such as the XY feed and Z plunge rates, dwell, spindle enable and tool
pause.

Before assigning these attributes, you must first select the tool. So, click on the green
tool bar. Notice that the depth is already filled in for you. You could enter the tool
depth in this dialog or the previous tool dialog. 

The x/y rabbit allows you to set the XY linear engraving speed for this tool. The Z
rabbit lets you set the Z plunge rate. There are two ways to set the speed. The easiest
is to click on the speed dial. The red dial indicator cycles from left to right as you click
on it. This sets the speed to slow (left), mid-range (middle) or fast (right). You can read
the set speed on a pop-up when the mouse cursor is resting on the dial.

The second way to set the speed is to override the default settings of these speeds for
this job. Click on either rabbit icon to bring up the Machining parameters dialog.

Simply enter the speeds desired for this job. The dwell time can also be set here. The
Load Default button loads the program default values which can be modified by the
user in the Options (F10) dialog. Don’t be concerned about entering too large a value.
The program’s post-processor limits the maximum table speed based on the engraver
model. A V3400 maximum speed is about 1.5 inches/sec whereas the IS400 maximum
speed is about 2.0 inches/sec.

Under the depth text box is the dwell time icon. Successive clicking on this icon
allows selection of three different dwell times or none. The dwell time defines how
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long the tool pauses between a plunge into the material and the subsequent XY
movement. This should allow the cutter to attain its full rotational speed if it slowed
any during its plunge.

The four icons to the right provide the following preparatory functions:

Enable/Disable spindle rotation. You would disable the spindle for use with
a  diamond drag operation.

Enable/Disable coolant (not used on the engraving equipment).

Enable/Disable an auxiliary output. This could be used to control a vacuum
table or chip collector.

Enable/Disable a tool pause. When enabled, the LCD on the engraver will
prompt you for the Tool Number. This should be enabled for jobs with
multiple tools.

The software can automatically calculate equal depths for multiple passes. To see an
example of this, click the “4” icon on the Machining tab to set up four passes. Click on
the Tool Properties tab and set a depth of 0.1”. Click on the Machining tab once again
and you will see that the depths are equally divided for the four passes (.025, 0.50,
0.75, 0.1).

Step 5: Setup Job for Machining

Click on the Machining icon  in
the main toolbar.

This dialog has many elements, so we
will discuss it by sections.

Engraving table selection

If more than one model is installed, choose it from the pull-down menu. If your
machine is not on the list, refer to Section 2-5, Installing a Table Driver, in this training
manual for assistance installing a new table driver.

Choose the Test option to check if any of the composition overruns the actual
engraving area. 

Lesson #6 — Tool Management by Color 
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The figure at right is an example
of an Error screen. It indicates an
object outside or overlapping the
engraving boundary. This could
occur unintentionally if you 

change the origin or swap the
axis.

The test mode is also used to view
the engraving instructions sent to
the machine, if not using the
binary drivers.

You may see a “Too large...”
message indicating that the file
size exceeds the view buffer size.
It is not an error condition. 

Choose the Port option to send
the job to the engraver.

Pass Table

This section of the dialog is the
same as the Machining dialog. You
can use either one. The speeds
used should be adjusted for the
material, cutter specifications and
depth of cut. These settings are
unique to each tool.

It is possible to define up to three
additional passes for the tool. To

define a second pass, for example, click on the ‘2’ button. This adds additional dials to
define the tool’s attributes for the second pass. Notice that you can define a different
depth. This feature could be used, for example, to define a finishing pass, or to clean
up chips, or to cut delicate or hard material.

Before clicking the OK button, remember to select the second tool and define its
attributes.

Clamping Method

There is a great deal of flexibility in selecting a clamping
method. The top icon is used for standard flat plate
engravers. Even though your job XY origin is in the lower
left, the post-processor automatically adjusts your job to fit
flush in the upper left of the table, near the home position.

The vise icon is used for center vise tables. The center of
your job is adjusted for the center of the vise.

The third and fourth icons allow you to define an exact XY 
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Step 5: Setup Job for Machining (cont’d)
origin (floating origin) referenced to the upper left or center of your job.

Axis Swap

This section allows you to send a
rotated and/or inverted job to the
machine. Be careful using this feature.
It is advised that you engrave in the air
the first time you use this, since there
is no way to verify the results in the
software. 

Also in this section, you define the Z-
lift parameter which is the how far the
tool is raised before moving to the
next area to be engraved.

Tool Path Management

Click on the Tool Path Select button to choose
one or more tool paths to be engraved. 

This invokes the tool Path Select Dialog box. 

This provides you the ability to fine-tune what you
output. 

Note: For a design that contains multiple objects,
only those objects selected before invoking
the Machining module will be engraved. If
no objects are selected, then the system
defaults to processing all the objects.

Collate

This dialog allows you to further
refine how the job is output.
Choose none if you want the job
sent to the table one tool at a time. 

Choose By Layer if you want to segregate toolpath transfer by layer. Or choose All, the
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default, to send all toolpath selected. Generally, you will ignore the Collate button and
use the default.

Automatic Stock Feeder and Job Tool Pause

You can enable the post-processor to output a special
command for an automatic
stock feeder. The icon to the
right overrides the tool pause
settings for all tools with a
single control for the job to be
transferred.

Tool List

You first select the tool from this list before modifying the tool’s attributes. These
attributes include XY speed, Z speed, depth, dwell, spindle enable and tool pause. 

OK, Run, Cancel

Click OK to apply changes to this dialog. If you
subsequently click Cancel, the settings are
remembered the next time that you enter this
dialog. Click Run to actually process the job for
test or to send to the port. Click Spooler to

invoke the Windows Print Spooler dialog. From the Spooler dialog, you can pause or
cancel a job that is being transmitted to the table.

Before you click on the Run button, make sure the machine is properly set up (refer to
the machine user’s manual):

• Clamp the material
• Use a depth-regulating nose cone
• Put the cutter in the spindle
• Set Z-ref
• Adjust the engraving depth with the nose cone micrometer
• Make sure the machine LCD reads ‘Ready To Receive’

Step 6: Save Your Work!

Hit Ctl-S or click File > Save on the menu.

Tech Note: Tool Order

Closed contours are machined before open contours. The machining order is
determined by the order in which the objects are created. This is optimized
only in so far as all contours using the same tool in the same pass are grouped
together.
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Tool Management by Color Summary

Step 1: Open the Simple Plate job from an earlier lesson.

Step 2: Color assignments

Open the Tool Properties window by clicking. Select the text to be colored and
double-click a color bar to assign the tool, by color, to the object to be engraved.
Repeat for any other objects. Any objects not selected will use the black tool (0) by
default.

Step 3: Tool and color association
Click on the properties button to invoke the Properties Sheet.

Click on a tool color bar and double-click on a tool from the library to associate the
actual tool with the reference color tool.

Step 4: Machining; or Pass Table
Click the Mechanisation tab and set the XY feed and Z plunge rates, Dwell, Spindle
enable and Tool pause enable. Do this for each tool in the job. Click OK.

Step 5: Setup Job for Machining
Click on the Machining icon.

Choose target engraver.

Choose vise or flat plate. 

For each tool:
• Click on speed dials to set speed.
• Set cutting depth
• Enable/disable spindle
• Enable/disable tool pause
• Set dwell time
• Choose additional passes, if required.

Select axis swap, if required.

Edit Z-lift

Choose Test and Run to make sure engraving is in the engraver area.

On the engraving machine:
• Clamp the material
• Use a depth-regulating nose cone
• Put the cutter in the spindle
• Set Z-ref
• Adjust the engraving depth with the nose cone micrometer
• Make sure the machine LCD reads ‘Ready To Receive’

Step 6: Save Your Work!

Lesson #6 — Tool Management by Color 
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This lesson demonstrates the simplicity and speed of  generating a matrix.

Objectives

Use matrix 

Design Specifications
Filename: Simple Matrix.vnd
Material Size: 8” x 6”
1st text line: HELVETICA 1L , 0.15 char height
Matrix size: 3 x 2 elements

Creating the Design

This design is intentionally trivial, to allow you to concentrate on the matrix function.
But you could use matrix with a design as complex as desired.

Step 1: Open a New File and Set Dimensions
Open a new file and set the job dimensions to 1.5” wide by .5” high.  Make all the
margins “0”.

Step 2: Design
Type in the text “GravoStyle98” in the HELVETICA 1L  font at a .15” character height.

Lesson #7 — Simple Matrix
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Click on the Matrix icon in the blue vane of the text pinwheel. On the Matrix
dialog shown, click in the grid and drag to the include the total number of elements
desired in the matrix. Alternatively, enter the number of rows (X) and columns (Y) in
the text boxes. We will make a 3 by 2 matrix.

Enter “0.15” for the space
between the matrix
elements. Also, enter “.25” in
the offset text box to allow a
border for clamping. Set the
axis cutting to None. This
specifies if or how the matrix
elements are cut. The Total
width and height parameters
are the default engraving
table dimensions. The
software limits the maximum
number of elements that will
fit within these total limits. 

Click OK.

Here’s how the material looks with 
no cuts between the matrix elements.
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Step 3: Save Your Work!

Tech Note: Approaches to Axis Cutting

There are two other approaches to Axis cutting. If Partial axis cutting is selected, it would
look like this:

If All (full) axis cutting is selected, it would look like this:

There are various ways to order the plates on the material. When Optimization is set to
None, you manually select this order by clicking on the appropriate icon in the ‘Presentation’
section (lower right corner) of the Matrix dialog. The arrows refer to the engraving direction
which is always left to right.

To obtain the best optimized cutting order, for the shortest run time, click the Optimized
option. The result with no axis cutting is:

:

Lesson #7 — Simple Matrix
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Simple Matrix Summary

Step 1: Open a New File & Set Material Dimensions
Set dimensions to 3” x 1” with no margin.

Step 2: Design
Type in the text “GravoStyle98” in the HELVETICA 1L  font at a .15” character height.

Open the Matrix dialog  from the blue pinwheel. Select a 3 by 2 matrix with a border
offset of “0.25” and the space between elements set to “0.15”.

Step 3: Save Your Work!
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In this lesson you will learn many ways to create a matrix with serial numbers

.

Objectives

Use matrix with automatic numbering

Design Specifications
Filename: serialization matrix.vnd
Material size: 8” x 2”
Plate size: 2” by 0.5”, 0” margins
Text: Arial at 0.25” height
Matrix: 3 by 3, 0.25” offset, full axis cutting, no optimization

Creating the Design

Again, this design is trivial so we can concentrate on matrix serialization. Like with
Simple Matrix, you could design a job as complex as desired. In the next lesson, we
will use variable list.

Step 1: Setting Up The Job
Open a new file and set the job dimensions to 2” wide by .5” high.  Make all the
margins 0”. 

Use the default Arial font at 0.25” character height.

Step 2: Composing the job
We are in Automatic Composition mode by default.
Enter the text “sn ”.

On the blue pinwheel, place a numeric variable by

clicking on  .

This presents the Variable dialog with the variable
name “NUM1” assigned by default.

Lesson #8 — Matrix with Serialization
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Click on the Variable List button which presents the Series Dialog so you can
define the series parameters.

Enter a starting sequence number of 000100, a step size of 1 and an ending sequence
number of 000108 as shown below.  Click Preview to see what you will get. 

Here is an alternative. Enter a starting sequence number of 100, a step size of 1 and an
ending sequence number of 108 as shown below. Click on Constant number of digits
and change the format to ######. Click Preview to see what you will get.

Here is another way we can use this dialog.

Click on Alphanumeric. Enter a starting sequence number of 100, a step size of 1 and
an ending sequence number of 108 as shown. Enter “sn “ into the Text before box.
Click Preview.

Lesson #8 — Matrix with Serialization
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Now add the text “ 1998” into the Text after text box and see what happens.

Another interesting way to use this dialog involves using letters. Click on Alphabetic
and enter “A”, “1” and “I” into the Start, Step and End text boxes. Click Preview.

And finally, here’s one more interesting way to use this dialog. Enter the parameters as
shown below.  This is how to get the numbers to decrement. Also, you can make the
numbers skip by entering a Step value other than 1.

To complete this exercise enter the values as shown below. Click Preview to check
your work. Click OK to accept.

Click End on the Variables dialog.
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Step 2: Composing the job (cont’d)
This is how the design looks.

You can apply attributes to the numeric variable just like any other text. Select the text
“|NUM1|” and click on the italic icon. Enter

Step 3: Create a Matrix
Now we will create a matrix. 

Click on the Matrix icon in the blue pinwheel.

As shown above, select a 3 by 3 matrix with 0.25” offset, all axis cutting and no
optimization. Click Ok.

Good job!

Step 4: Save Your Work!

Lesson #8 — Matrix with Serialization
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Matrix with Serialization Summary

Step 1: Setup job

Open a new file.

Set the material size to 2 by 0.5 with 0 margins.

Edit character height to 0.25” using the Arial font.

Step 2: Compose the job

Type “sn”.

On the blue pinwheel, place a numeric variable by clicking on .

Click on the Series button on the Variables dialog. Enter 100, 1 and 108 for the Start,
Step and End parameters. Click Preview. Then click Ok to accept.

Click End to close the Variables dialog.

Alter the variable name text “|NUM1|” to italics.

Step 3: Create the matrix

Click on the Matrix icon in the blue pinwheel. Select a 3 by 3 matrix with “0.25”
offset, full axis cutting and no optimization. Click OK and you’re done!

Well almost.

Step 4: Save Your Work!
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GravoStyle ’98 provides the capability to automate text entry on a series of plates. These
plates can all be on one piece of material or one piece of material per plate.

Learning Objectives
Use automatic mode
Use matrix with variable list

Design Specifications
Plate size: 2” by 1.5” 
Material size: 8” by 6”
1st Line Arial, 0.3” char height
Filename: variable list matrix.vnd

Creating the Design

We will start by making a master plate. The design is very simple, consisting only of a
single variable. A list of names will be imported from a file.

Step 1: Define the plate 
Open a new file and set material dimensions to 2” by 1.5”. The plate dimensions must
be small enough to allow a minimum of two plates to fit in the engraving area. If not,
the software will prohibit the matrix operation.

Step 2: Assign a variable 
Press F12 to select the character height box. Type “0.3” and hit Enter. Click on the

variable list icon  on the blue pinwheel. Click OK on the Select Variable dialog to
accept and place the VAR1 variable.

Lesson #9 — Matrix with Variable List
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Step 3: Import the Text

Click on the variable edit icon on the blue pinwheel. Click the Import button
on the Variable dialog. Look in the Matrix subdirectory of the lesson diskette and
select the file: names.txt. A message box pops up and asks if you want automatic
extraction. Click OK. You should now see a list of 16 names. You can edit, add or
delete in this list. Sorting is not supported at this time. So, if you need a sorted list,
be sure to sort before importing. Select the number 1 from the Show State pull-
down menu. This instructs the software to display the actual text rather than the
variable name. Click End to accept the list.

Step 4: Generate the Matrix

Click on the Matrix icon  on the blue pinwheel. Select a 4 by 4 matrix by
dragging the mouse cursor in the grid. Choose Axis Cutting equal to All. Click OK to
accept. The finished example shows one name per plate on one piece of 8 x 6
material. If necessary, any plate can be edited.

Step 5: Save your work!

Tech Note: Text List
Creation

You can create your own
list in Notepad. Type each
name on its own line. Each
line should end with a
carriage return except for
the last line.

Lesson #9 — Matrix with Variable List
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Matrix with Variable List Summary

Step 1: Define the plate
Set the plate dimensions to 2” by 1.5” with automatic borders.

Step 2: Assign a variable

Change the character height to 0.3. Click on the variable list icon on the blue
pinwheel and click OK.

Step 3: Import the Text

Click on the variable edit icon on the blue pinwheel. Select import and find the
text file of names. Show State 1 and click End.

Step 4: Generate the Matrix

Click on the Matrix icon on the blue pinwheel. Select a 4 by 4 matrix. Select All
for Axis Cutting and click OK.

Step 5: Save your work!
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Lesson #10 — Complex Matrix Design: Putting It All Together

Numbers and text can be mixed in a job with other graphical design elements to any degree
of complexity required. This lesson will show you how to combine multiple variables,
typical of data output from a database.

Objectives

Matrix with combined variable list and serialization

Design Specifications

Plate size: 3” by 2” 
Material size: 6” by 8”
1st & 2nd lines: US BLOCK 1L, 0.15” char height
3rd & 4th lines: blank
5th line: US BLOCK 1L, 0.1” char height
Filename: complex matrix.vnd

Creating the Design 

The master plate consists of several variables. A list of names will be imported from a
file. Numbers will be generated by the serialization routine. The general approach is
listed below:



4-72

New Hermes GravoStyle’98 Tutorial

•Define the master plate size
•Set default text attributes
•Add the variables
•Import data
•Compose plate and place variables
•View live data

Step 1: Define the plate 
Open a new file and set material dimensions to 3” by 2”. 

Step 2: Set text attributes 
Press F12 to select the character height box. Type 0.15. Select US Block 1L font and hit
Enter. 

Step 3: Set up the variables
In this step, the variables will be added and their names customized. 

Click on the variable edit icon  on the blue pinwheel. Right click the VAR1
column heading and select Edit Name of Variable from the pop up menu. Highlight the
heading text and type the word Name followed by Enter. Right click the area again and
select Add a Variable. Type the word Department followed by Enter. Right click the
area again and select Add a Variable. Type the word Ext followed by Enter. Right click
the area a final time and select Add a Variable. Type the word Empl# followed by
Enter.

Step 4: Import the Data
Click to place the cursor
anywhere in the first column.
Click the Import button on the
Variable dialog. Look in the
Matrix subdirectory of the lesson
diskette and select the file:
databaseList.txt. A message box
pops up and ask if you want
automatic extraction. Click OK. 

Click in the Empl# column and
click on the Series button. Under
Parameters, enter 1 for Start and
Step and 16 for End. Click
Preview to see a list of numbers
from 1 to 16. Click OK to place
these numbers in the Empl#
column. Drag the dialog box
wider, as required, to see all four columns as shown.

Click End on the Variable dialog.

Lesson #10 — Complex Matrix Design: Putting It All Together
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Step 5: Compose the Master Plate

Click on the Select Variable icon and select the Name variable from the list. Click
OK. Hit the Tab key to add space. Click on the Select Variable icon again and select the
Ext variable. Click OK. 

Hit enter to move to the second line in the composition. Type “Employee: “Add the
Department variable. Hit enter three times to move to the fifth line in the composition.
Add the Empl# variable. Select the text on the fifth line, left justify it and change the
character height to 0.1.  

Go into Select mode and click on the Shapes icon. Select the star and place a 7-pointed
star in the design. The master plate should look something like this:

Step 6: Inspect with Live Data
To get an idea how the plate will look with live data, click to open the Edit
Variable dialog . Move the dialog to the bottom of the screen, far enough down to
expose the composition and yet still see the Show State pull-down menu in the dialog.
Change the Show State value to 1, 2, 3 and so on to see the actual data. 
This is what the last record looks like. 
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Step 7: Generate the Matrix

Click on the Matrix icon  on the blue pinwheel. Select a 2 by 4 matrix by
dragging the mouse cursor in the grid. Choose Axis Cutting equal to All. Click OK to
accept. The finished example shows one name per plate on one piece of 6 x 8
material. 

Step 8: Save your work!

Lesson #10 — Complex Matrix Design: Putting It All Together
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Complex Matrix Design Summary

Step 1: Define the plate
Set the plate dimensions 3” by 2” with automatic borders.

Step 2: Set text attributes
Set the character height to 0.15” and the font to US Block 1L.

Step 3: Setup the variables
Open the Variable Edit dialog .

Step 4: Import the Data
Place the cursor in the Name column and click Import. Import the text file:
databaseList.txt. Click OK to accept automatic extraction. Add a series of numbers
from 1 to 16 in the Empl# column.

Step 5: Compose the Master Plate
Open the Select Variable dialog .

Step 6: Inspect with Live Data

Open the Edit Variable dialog . View live data by changing the Show State value.

Action You Type

Select Name variable Tab

Select Ext variable Enter

Select Department variable Enter, Enter, Enter

Select Empl# variable Select line

Left justify, character height = 0.1

Add 7-pt star

Action You Type

Right click in the data section “Edit Name of Variable” Name

Right click in the data section “Add a Variable” Department

Right click in the data section “Add a Variable” Ext

Right click in the data section “Add a Variable” Empl #
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Step 7: Generate the Matrix

Click on the Matrix icon  . Select a 2 by 4 matrix. Select All for Axis Cutting and
click OK.

Step 8: Save your work!

Lesson #10 — Complex Matrix Design: Putting It All Together
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This job will introduce the column function. This function formats columnar text in the
engraving area. The column object that is created is fully editable since all user-defined
parameters are stored with the job. Each element in the column object can be individually
formatted. The user has control over the presence of lines separating the elements. You can
create multiple column objects in your design.

Objectives
Text on arc 
Alignment
Columns
Drill holes

Design Specifications
Filename: Plaque with Columns.vnd
Material Size: 6”W x 8”L
1st text line: 0.25” height, US BLOCK 1L
2nd text line: 0.25” height, US BLOCK 1L
3rd text line: 0.35” height, US BLOCK 1L
4th text line: 0.5” height, SCRIPT 2L
Column object: 6” wide by 2” high

4 rows, 3 columns
center at 3, 2
left justified text
15% left and right text border

Creating the Design

This is a basic plaque design with the addition of text in columns. We will start in
Automatic composition mode since it’s easier to layout the text on the material in this
mode. Then we will put text on an arc which forces Manual mode. Next, we will add
the columns object and text entries. The columns function also forces Manual mode.
And finally, we will add the mounting holes.

Step 1: Define the plate 
Open a new file and set the material dimensions to 6”W by 8”L. Accept the default
margins.

Step 2: Add text to the plaque

Starting in automatic mode, press F12 and enter a character height of 0.25”. Choose
center justification and change the font to US BLOCK 1L. Hit Enter to apply. Type the
text “GREENVILLE SOCCER ASSOCIATION”. Don’t worry that the text is condensed. It
will be spaced out after being placed on an arc. Hit Enter for a new line. Type the
words “Eastern Division”. Enter. Next, change the character height to 0.35” and type
“Champions”. Then at a character height of 0.5” and using the SCRIPT 2L font, type
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“The Panthers”. Here’s our progress so far
(see figure, right).

Now we will put the first line of text on an
arc. Click anywhere on the first baseline.
Click on the Text on an arc icon  on the
Blue pinwheel. Click Yes on the next
dialog to activate Manual mode. Enter the
parameters as shown in this Text on arc
dialog. That is, set radius to 2.5” with text
above arc. Accept the default X, Y origin
(below).

The cursor should be at the beginning of the arc
text line. If not, hit the Home key.  Select all the
arc text by pressing Shift and End together.
Change the Character width by editing the  text
box on the green pinwheel to 125%. 

Now we will
reposition

the center of the bottom three lines of text to the
arc center. Click on the Select mode icon. Drag a
horizontal guideline down until it touches the ends
of the arc text. Drag a vertical guideline to the
vertical center at X=3. 

Create a rectangle object enclosing the bottom
three lines of text. Adjust as necessary. This will be
used as a reference object to find the center of the
selected text. Now, select only the bottom three
lines of text. If you have inadvertently selected the
rectangle as well, Control click on it to deselect. 

Click the Move icon  on the Transformation toolbar. Hit F3 and select Gravity center.
Click OK. Hold the mouse cursor over the rectangle until you see the small red hit
circle. Click the left mouse button. Notice as you move the mouse cursor, you have
positioning control of the selected text referenced to the center of the selection. Hit
F3 and click on Grid and guides. Click OK. Move the mouse cursor near the
intersection of the two guidelines. Click the left mouse button when you see the small
red hit circle. Select the rectangle and hit Delete. 

(See figure at the top of the next page).
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Step 3: Define the Columns

A column object consists of an even number of
cells organized in an XY grid pattern. Click on
the Text mode icon to go into text mode.
Click the cursor anywhere in the bottom half
of the material. Choose the font to be used in
the column object. Press Enter to apply. Now

click on the Column icon on the blue
pinwheel. The Text in Columns wizard is
presented which allows you to create a
column object. (See figure below).

You now choose which one of two
methods you will use to create the column
object. In the first method, you define
columns in terms of the first base line; its
position, cell width, text width, vertical
space between baselines, etc. In the second
method, you define columns in reference to
the overall frame; the number of columns,
frame width and height, etc. The
parameters used in these two methods are
interrelated, so, the choice of which
method to use is a matter of personal
preference. Once the column object is
created, you can go through the wizard
again using either method. In fact, even
before the object is created, you can back

up to the beginning of the wizard and
choose the other method. Any
parameters you set in the first method
are remembered in the second method.

Using the Base line position method, set
the character height to 0.2”. All the text
in the column object will have this
character height. Later, you can change
the text attributes for each individual
cell. Click the Next button. (See figure,
left).

Set the left of the first baseline to the XY
position of 0,3. This sets the position of
the column object in your design as
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referenced from the left side of the baseline
of the cell in the upper left. Set the number
of rows to 4 and the number of columns to
3. Make the Column width 2”, the Text
width 1.4 and the Line space 0.5. Click the
left justify text alignment icon. This makes
all columns left justified. 

You can define the column justification
differently for each column. Just use the
horizontal slide bar to select the column
and then click on the alignment desired. In
the same manner, each column’s width can
be made different. Just clear the ‘Same
width of columns’ check box, select the
column with the horizontal slide bar and
enter the width in the Column width text
box. 

Click Finish and you will be ready to
enter text as described in the next step.

Now, we will run through the wizard
again using the frame position method.

Invoke the column wizard. There are
two ways to invoke the column wizard
using an existing column object. If you
are in text mode, place the cursor on
any text baseline and click the Column

icon . If you are in point mode,
double click any object in the column.
Choose the Frame position method.

Click Next.

Notice that the parameters are
remembered from the previous method
of defining the column object. There are
some differences. The XY position is now
referenced to the frame. Also, you can set
the overall width and height of the frame
and the wizard will calculate the
individual cell width and height based on
the number of rows and columns you
want. 

Click Next.
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Step 3: Define the Columns (cont’d)

In this dialog, you turn on and off the
horizontal and vertical rules using the
four icons below the preview grid.
These icons toggle the grid lines on
and off which are displayed on the
preview grid.

All lines, including the outside border,

horizontal and vertical rules .

Outside border 

Horizontal rules 

Vertical rules 

You can also select the tool used to cut these lines
and the line thickness in this dialog. 

Turn off all lines and click Finish.

The column object is created. In the picture at
right, the small red square in the center of the
column object is its reference point. The column
object can be moved by clicking and dragging this
point. The text baseline for each cell is defined and
ready for text placement. All text parameters such
as font, height, justification, etc. are defined but
can be changed.

Step 4: Column Text Entry
Click on the text baseline in the upper left cell of the first column. You must click the
cursor on the baseline accurately or you will miss the defined baseline and add a text
baseline that is not part of the column object. Line up the cursor’s horizontal cross hair
with the defined baseline as shown. Notice that the red text cursor snaps to the left of
the column baseline as defined by its justification.
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CORRECT INCORRECT

Start entering the names of the players on the
Panthers team. Use any names you wish. Type the
first name and hit Enter to move to the next line.
Continue entering names until all twelve cells are
filled. Hitting Enter at the end of a column will
position the cursor in the cell at the top of the
next column to the right.

You can use the Tab key to move to the next
column or Shift Tab to move to the previous
column on the same row. Use standard word
processing key combinations to move and select
text within the cell. For example, Home/End
positions the cursor to the beginning/end of the
text line. Shift Left/Right arrow selects letters to
the left/right.

Step 5: Drill Holes
Click on the Drill hole icon  in the
Shapes toolbox.

Enter a drill depth of 0.13” and
drill diameter of 0.25”. Select four
holes and enter a spacing of 0.5”
from the edges. Click OK.

Step 6: Save your work
Always remember to save your
work frequently.
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Plaque with Columns Summary

Step 1: Define the plate 
Set the material dimensions to 6”W by 8”L.

Step 2: Add text to the plaque
Type the text “GREENVILLE SOCCER ASSOCIATION” in US BLOCK 1L font at 0.25”
character height. Type “Eastern Division” on the second line. Change the character
height to 0.35” and type “Champions” on the third line. And finally, type “The
Panthers” on the fourth line in SCRIPT 2L font at 0.5” high.

Click in the first line of text and click on the Text on arc icon on the Blue pinwheel.
Enter a radius of 2.5”. Select all the text on the arc and change the character width to
125%.

Add a horizontal guideline at the bottom of the arc text. Add a vertical guideline at 3”.
Add a rectangle around the bottom three lines of text. Select these three lines of text.
Start a Move operation  and Snap to Gravity center. Finish the move operation with
Snap to Grid and guides at the intersection of the two guidelines. Delete the rectangle.

Step 3: Define the Columns
To setup the default text attributes to be used in the columns, type a letter in the
lower half of the job. Set the font to US BLOCK 1L. 

Click on the Column icon on the blue pinwheel. For Position of frame, enter X=3
and Y=2. Click on the center reference.

Change rows to 4 and columns to 3. Make the column width 2” and cell height to 0.5”.
Edit the bottom border to 0.1”.

With the text cursor in the baseline of a cell, click the Column icon to edit the Column
object. Select the ‘Borders and strokes’ tab. Click the All borders icon to turn off
borders.

Step 4: Column Text Entry
Click in the top left cell on the text baseline. Manually enter all the names. Hit Enter to
move to the next cell. Hit Tab or Shift Tab to move to the next or previous column
respectively.

Step 5:  Drill Holes
Click on the Drill hole icon  in the Shapes toolbox. Enter a drill depth of 0.13” and drill
diameter of 0.25”. Select four holes and enter a spacing of 0.5” from the edges. 

Step 6: Save your work.
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Lesson # 12— Simple Laser Engraved Plaque

In this lesson, you will learn the basics of laser engraving with GravoStyle’98. You will learn
how to do both vector and raster laser engraving. You will learn how to use the laser drivers
provided with your laser engraver and how to use the various GravoStyle’98 print options. 

Objectives
Raster or vector laser engraving
Select laser driver
Choose printer options
Setup job in laser engraver

Design Specifications
File: simple laser.vnd
Material Size: 4” x 4”
Text lines #1 & 2: 0.35” character height, center justified, Arial font

Creating the Design

This design consists of two lines of text. It is intentionally very simple in order to
concentrate on the steps required to complete the laser engraving process. A more
advanced laser engraving tutorial follows this lesson.

Step 1: Define the plate size
Open a new file and set the plate size to 4” x 4”. Accept the default margins and click
OK.

Step 2: Create the Job
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Hit F12 and set the character height to 0.35”. Choose center justification and select
Arial font. Enter to accept. Type “GravoStyle’98” on the first line. Select this text by
dragging the text cursor through it. Press the Ctl + C key combination (or Edit>Copy)
to copy this text to the clipboard. Click at the end of the first line and hit Enter to start
a second line. Press the Ctl + V key combination (or Edit>Paste) to paste this text
from the clipboard.

Step 3: Raster or Vector Engraving

Click on the View pull-down menu (right).

The selected view will determine whether the job
will be raster or vector engraved. 

During raster engraving, the laser moves back and
forth in a hatch pattern to do filling. During vector
engraving, the laser follows the defined contours.

You would select Wire contours for vector
(outline engraving) and select Filled contours for
raster (filled engraving). In Discovery and Industry
levels, raster and vector engraving are separate
operations as explained later in this tutorial. To do
both operations simultaneously requires the
vectorization option as detailed in the Advanced
Laser Plaque tutorial. Vectorization is included in
Graphic and Dynamic levels.

Basically, with the Vectorization tools, you are able
to break a closed contour so that it will not be
filled.

The picture in Step 2 above represents the Wire
contours view and when sent to the laser engraver
will engrave just the outline (vectors). The picture
below represents the Filled contours view and



4-88

New Hermes GravoStyle’98 Tutorial

when sent to the laser engraver will be raster engraved.

It is possible to vector engrave after
raster engraving using a feature in the
laser engraver driver. This is discussed
below. 

In text mode, click on the Manual

mode icon to enter Manual mode.
This separates the 2-line text object
into two text objects. 

In this lesson, the first line will be
vector engraved and the second line
raster engraved. This will be done as
two separate transfers to the laser
engraver. For the first transfer, the first
line of text will be selected in Wire
contour view mode. For the second
transfer, the second line of text will be

selected in Filled contour view mode.

Click on the Select arrow icon  and select the first line text. Change to Wire
contours view.

Step 4: Setup to Engrave

Click on the printer icon in the Main
toolbar of GravoStyle98. Click on the Setup
command button on the Print dialog. Choose
the appropriate laser engraver from the pull-
down list (see figure, right).

If your laser engraver is not on this list, you
must go back and install it from the disk

provided with the machine. Refer to the
instructions in the laser engraver manual also
provided with the machine. 

Choose Landscape orientation. Click on the
Properties command button.

In the Printer Properties Dialog (left), click on
the #1 black color property item. Select the
power and speed appropriate for the material to
be engraved. Click Set. Make sure that ‘Clipart
Mode’ is unchecked. The PPI and DPI settings are
your choice. You need only set the properties for
“black “ since our design uses only this color.

Lesson # 12— Simple Laser Engraved Plaque
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Step 4: Setup to Engrave (cont’d)
In the Pen Mode field, on the left side of the dialog, you can choose between raster
and vector, raster only, vector only or skip (none) for the associated color. You
sequence through these choices
with each click on the square. For
now, the state of this setting is of
no consequence since
GravoStyle’98 is in Wire contours
view.

Click the Engraving Field tab in
this dialog (right). Change the
Width and Height fields to 4 each
to match the actual plate
dimensions. Choose Landscape to
raster left and right. Portrait
orientation would be selected to
raster up and down. Since the line
of text is longer than higher, the
motion of the laser will be more
efficient in Landscape orientation.

Click OK twice until you see the
Print dialog (left).

In ‘Print Range’, click Selection. 

Note: If you want to also engrave the material
border, then set the print range to ‘All’. Be sure
to check the border color. It must match one of
the colors in the Laser Settings tab of the laser
driver properties dialog (above). The border
color can be changed in the Color properties
tab of the Options (F10) dialog. 

Uncheck ‘Print to File’, ‘Center’ and ‘Info’.
Make sure the scale is 100%. By unchecking
‘Center’, the job will be engraved in the
upper left corner of the engrave area. By
unchecking Info, the filename will not be
engraved. Click OK to send the file to the
laser engraver.

Step 5: Engrave
Engrave line 1

Put your 4” x 4” material in the upper left of the engrave area of the laser engraver at
the intersection of the two rulers. Press the Next File and the Start buttons successively
on the laser engraver to begin the engrave process. If your laser has a spotting beam,
you can do a test run of the job by leaving the door open before pressing Start.
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Engrave line 2

Select the second line of text and switch to Filled contour view mode. In the Pen Mode
field, choose raster only for the black color. With this setting, the engraving time is
shortened since the engraver will not vector engrave after raster engraving.

Click the Print icon and click OK to send the file to the laser engraver. Press the Next
File and the Start buttons successively on the laser engraver to engrave the second line
of text.

Step 6: Save your Work

Press Ctl S to save the file
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Simple Laser Plaque Summary

Step 1: Define the plate size
Open a file and set plate size to 4” x 4”.

Step 2: Create the Job
Type “GravoStyle’98”, with character height of 0.35”, center justification and Arial
font. Add a second line identical to the first.

Step 3: Raster or Vector Engraving
From the View pull-down menu, select Wire contours for outline (vector) engraving.

Step 4: Setup to Engrave
Select the objects to be engraved which, in this case, is the first line of text. Click the
print icon. Click the Setup button in the Print dialog. Select the laser engraver from the
pull-down list. Choose Landscape orientation.

Click on the Properties command button. Set the power and speed for your material
using the black line item.

Click the Engraving Field tab in this dialog and set the size to 4” by 4”. Click OK twice
until you see the Print dialog. Choose the following settings:
Print Range = Selection
Print to File = none
Center = none
Info = none
Scale = 100%

Step 5: Engrave
Put your 4” x 4” material in the upper left of the engrave area at the intersection of the
two rulers. Press the Next File button and then the Start button on the laser engraver
to begin the engrave process. 

In the Pen Mode field, choose raster only for the black color. Select the second line of
text and change to Filled contour view mode. Click the Print icon and click OK to
send the file to the laser engraver. Press the Next File and the Start buttons on the

laser engraver to begin the engrave process.

Step 6: Save your Work

Press Ctl S to save the file
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Lesson #13 — Advanced Laser Engraved Plaque Using Vectorization Option

In this lesson, you will learn some advanced laser engraving techniques using GravoStyle’98.
You will learn how to do both vector and raster laser engraving in one operation. You will
also learn to do reverse laser engraving.

Objectives
Alignment tools
Raster and vector laser engraving
Reverse engraving
Select laser driver
Choose printer options
Setup job in laser engraver

Design Specifications
File: Advanced Laser Plaque.vnd
Material Size: 4” x 4”
Text lines #1 & 2: 0.35” character height, center justified, Arial font

Creating the Design
Like the Simple Laser Plaque, this design is simple consisting of two lines of text. There
is a box around the second line for the reverse engraving. And there is a border
engraved near the material edges. The text is filled (raster engraved) while the border
is not filled (vector engraved).

Step 1: Define the plate size
Open a new file and set the plate size to 4” x 4”. Accept the default margins and click
OK. 
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Lesson #13 — Advanced Laser Engraved Plaque Using Vectorization Option

Step 2: Create the Job

Hit F12 and set the character height to 0.35”. Choose center justification and select
Arial font. Enter to accept. Type “GravoStyle’98” on the first line. Enter to start a
second line of text and type “98” on the second line.

Click on the Manual mode  icon and accept the warning. This separates the two
lines of text into two separate text objects.

Click on the Shape toolbox icon and select the Create rectangle tool. Draw a
small rectangle around the ‘98’ and another larger rectangle near the edges of the
material. Don’t worry about alignment yet. We will use GravoStyle98’s powerful
alignment tools next. These alignment tools are available in Industry and higher levels.

Click the Select tool to exit the Rectangle
tool. Select the outer rectangle. Open the

Alignment toolbox . Click on Vertical

and Horizontal balancing to
center the selected object in the material.

Select the text ‘98’. Add the rectangle
surrounding the ‘98’ to the selection by

Control clicking on it. Click on Vertical 

and Horizontal Center icons to align
the second selected object to the first
selected object.

Step 3: Set up for Raster Engraving

Click on ‘Convert to curves’ to convert the selected text object to lines and arcs.
This is necessary for reverse engraving.

Change the view to ‘Filled contours’ from the pull-down menu. Notice that the area
inside the border is filled, obliterating the design. All closed contours are filled by the
laser raster engraving mode. So we must open or break this border contour so that it
will be vector engraved. Change the view back to Wire contours.

Select the outside border rectangle and click the Point mode icon . Notice the
four square points defining the corners of the box. One of the corners actually consists
of two overlapping points. The larger square point is the start point for this contour.
This is where engraving will start for this contour. Notice also, that the color of the
contour is green or blue indicating that this contour is closed; that is, the start and end
points are connected. 
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Step 3: Set up for Raster Engraving (cont’d)

Click on one of the points. Then click on the disconnect icon . Notice that the
color of the contour changed to black indicating that this is an open contour. The
disconnected corner consists of two points overlapped. Change the view to ‘Filled
contours’ from the pull-down menu.

The outer border no longer fills the design as expected. However, the ‘98’ is obscured
by its surrounding box (see figure, next page). Go back to Select mode. Drag 

Tech Note: Alignment Tools

When using the alignment tools (except for balancing and spacing), the first selected object is used as a
reference for all subsequently selected objects. The example below shows each tool’s specific effect on the
objects selected in the order shown.

Action Result

The original design 

Align left
Align the left of all selected
objects to the left of the first
selected object.

Align Top

Align the top of all selected
objects to the top of the first
selected object.

Align bottom

Align the bottom of all
selected objects to the
bottom of the first selected
object.

Align right

Align the right of all selected
objects to the right of the first
selected object.

Align Center

Center all selected objects
vertically with the center of
the first selected object.

Align Horizontal

Center all selected objects
Horizontally with the center
of the first selected object.

Action Result

Horizontal Boxing

Adjust the width of all selected
objects to match the width of
the first selected object.

Vertical Boxing

Adjust the height of all selected
objects to match the height of
the first selected object.

Boxing 

Adjust both the height and
width of all selected objects to
match the height and width of
the first selected object.

Horizontal Spacing

Adjust the horizontal position of
all selected objects between
the two outermost selected
objects for equal spacing.

Vertical Spacing

Adjust the Vertical position of
all selected objects between
the two outermost selected
objects for equal spacing.
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Lesson #13 — Advanced Laser Engraved Plaque Using Vectorization Option

Step 3: Set up for Raster Engraving
(cont’d)

a selection box around this black

rectangle. Click on the Link icon .
This action groups the ‘9’, ‘8’ and
rectangle which, in turn, allows contours
to be filled in the proper order (below). 

Note: Grouped contours are
filled in an alternating order
starting from the outside. So, if
you have four grouped contours
fully containing in one another,
the fill pattern is as shown in the
example (right).

Select the outer border. Click

on the Color icon in the
Main toolbox to open the Machining tools dialog  (left). 

Double-click on the red bar (Tool 1) to assign these selected
contours to the color red. Later, we will assign a specific laser
power level to this color

Step 4: Setup to Engrave
You should

still be in ‘Filled contours’ view.
Remember, this ‘painted’ view is
required to do any raster laser
engraving. Select all objects in the
design using the Ctl-L hotkey.Click

on the printer icon in the
Main toolbar of GravoStyle98.
Click on the Setup command
button on the Print dialog. Choose
the appropriate laser engraver
from the pull-down list.



4-97

New Hermes GravoStyle’98 Tutorial

If your laser engraver is not on this list, you must go back and install it from the disk
provided with the machine. Refer to the instructions in the laser engraver manual also
provided with the machine. 

Choose Landscape orientation. Click
on the Properties command button.

Click on the #1 black color property
item. Set the power and speed to be
appropriate for the material to be
engraved. Click Set. Click on the #2
red color property item. Set the power
higher than that for black since this is a
very thin line. Click Set.

Make sure that ‘Clipart Mode’ is
unchecked. The PPI and DPI settings
are your choice. 500 is a good starting
choice.

In the Pen Mode field, on the left side
of the dialog, you can choose between
raster and vector, raster only, vector
only or skip (none) for the associated color. You sequence through these choices with
each click on the square. Choose Raster/Vector mode.

Click the Engraving Field tab in this
dialog (right). Change the Width and
Height fields to 4 each to match the
actual plate dimensions. Choose
Landscape to raster left and right.
Portrait orientation would be selected
to raster up and down. Since the
design is longer than higher, the
motion of the laser will be more
efficient in Landscape orientation.

Click OK twice until you see the Print
dialog.

In ‘Print Range’, click Selection.
Uncheck ‘Print to File’, ‘Center’ and
‘Info’. Make sure the scale is 100%. By
unchecking ‘Center’, the job will be
engraved in the upper left corner of the engrave area. By unchecking Info, the
filename will not be engraved. Click OK to send the file to the laser engraver.

Step 5: Engrave the Job
Put your 4” x 4” material in the upper left of the engrave area at the intersection of the
two rulers. Press the Next File button and then the Start button on the laser engraver 
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Lesson #13 — Advanced Laser Engraved Plaque Using Vectorization 

Step 5: Engrave the Job

to begin the engrave process. If your laser has a spotting beam, you can do a test run of
the job by leaving the door open before pressing Start.

Notice that the entire job is engraved with one data transfer to the engraver. This is in
contrast to the job discussed in the Discovery section for “Simple Laser Engraved
Plaque”.

Step 6: Save Your Work!

Press Ctl S to save the file.
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Advanced Laser Plaque Summary

Step 1: Define the plate size
Open a new file and set the plate size to 4” x 4”. Accept the default margins and click
OK. 

Step 2: Create the Job

Hit F12 and set the character height to 0.35”. Choose center justification and select
Arial font. Type “GravoStyle’98” on the first line and “98” on the second line.

Go into Manual mode . Draw a small rectangle around the ‘98’ and another larger
rectangle near the edges of the material. Select the outer rectangle and click on

Vertical and Horizontal balancing to center the selected object in the
material. 

Select the text ‘98’ and the small rectangle surrounding the ‘98’. Click on Vertical  

and Horizontal Center  to center the rectangle to the text

Step 3: Set up for Raster Engraving

Click on ‘Convert to curves’ to convert the selected text object to lines and arcs.  

Select the outside border rectangle and click the Point mode icon . Click on one

of the points. Then click on the disconnect icon . 

Drag a selection box around the text ‘98’ and the small black rectangle. Click on the

Link icon .

Step 4: Setup to Engrave
Select the objects to be engraved using the Select All hotkey Ctl-L. Click the print icon.
Click the Setup button in the Print dialog. Select the laser engraver from the pull-down
list. Choose Landscape orientation.

Click on the Properties command button. Set the power and speed for your material
using the black line item. Set a slightly higher power level for the red color which is
the design’s border.

Click the Engraving Field tab in this dialog and set the size to 4” by 4”. Click OK twice
until you see the Print dialog. Choose the following settings:
Print Range = Selection
Print to File = none
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Center = none
Info = none
Scale = 100%

Step 5: Engrave the Job
Put your 4” x 4” material in the upper left of the engrave area at the intersection of the
two rulers. Press the Next File button and then the Start button on the laser engraver
to begin the engrave process. 

Select the second line of text and change to Filled contour view mode. Click the Print
icon and click OK to send the file to the laser engraver. Press the Next File and the
Start buttons on the laser engraver to begin the engrave process.

Step 6: Save your Work

Press Ctl S to save the file
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NOTES:
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“What You See Is What You Really Engrave”

This tutorial shows how to use the WYSIWYRE function for viewing your job with photo-
realistic materials showing representations of actual New Hermes’ materials that can be
purchased. This exercise will also show how to perform a side-by-side comparison of the
same job using different materials.

Objectives
Use File Find
Use WYSIWYRE

Design Specifications
File: simple plate.vnd
Material Size: 6W x 2H

Creating the Design

We will use the Simple Plate design from Lesson #2 to demonstrate WYSIWYRE.

Step 1: Open the Job
From the file menu, choose Find. This file utility helps
you to find a file if you don’t remember the directory in
which it is stored. In the navigation box on the left
choose the directory in which you want to start the file
search.

Click Find in dir to display all jobs in the selected
directory or click Find in all sub dir to enable searching
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in all subdirectories as well.

Choose the sort order for the job file list.

The Creator and customer data are entered by the
designer when creating the job. This dialog can be
found from the menu: File > Information. Although it
is optional, it’s a good idea to include this extra
information with each job file to facilitate searching
for the file later.

Highlight the job in the upper panel and you will see a
thumbnail of the job below.

Find the simple plate.vnd job. 

Click Open to open the job.

Step 2: Viewing toolpath in WYSIWYRE

Click the WYSIWYRE icon on the Main toolbar to go into the WYSIWYRE
function. Every visual aspect of this job can be modified. You can change the
background color, the material type, the fill color and the engraving width. If you have
defined the tools to be used for each color of the design, you will see the actual
toolpath in WYSIWYRE. (See figure, top of next page.)
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Step 2: Viewing toolpath in WYSIWYRE (cont’d)

This job uses a 0.030” Gravoply tool for the bold letters and a 0.010” Gravoply tool for
the thin letters. WYSIWYRE is a tool to help you can see if your chosen tool(s) yields
the desired effect. 

If the chosen tool is too large,
you can have overlapping
letters.

If the tool is too small, you will
see undesired spaces in the
letters.

Change the cutting width from the pull-down menu; Tools > Engraving width or click

the  icon until you are satisfied with the results. WYSIWYRE only lets you change
the cutting width for the entire job. Therefore, if the job uses more than one tool, exit
WYSIWYRE, change the tools in GravoStyle'98 and then return to WYSIWYRE.

Step 3: Selecting the
material in WYSIWYRE
Select a material from the pull-
down menu or by clicking an
icon on the main toolbar.

You can select any material that
New Hermes Inc. offers.
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Step 4: Change the fill color in WYSIWYRE
If desired, select a fill color from the pull-down menu or

by clicking the  icon on the main toolbar.

Slide the horizontal control bars for the red, green and
blue colors to get the color desired. 

Step 5: Change the background color in WYSIWYRE

If desired, select a background color from the pull-down menu or by clicking the 
icon on the main toolbar. The background is behind the material. This could be useful
to simulate the environment where the sign or plaque would be placed.

Step 6: Compare multiple versions of the same job in WYSIWYRE
There may be a need to show a customer different materials from which to choose.
From the pull-down menu, choose Window > New window. Then choose Window >
Tile. You now see a duplicate job. Choose the material, fill color and background
desired for this new window.

Step 7: Save your Work
Press Ctl S to save the file
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WYSIWYRE Summary

Step 1: Open the Job
Open the simple plate.vnd job.

Step 2: Viewing toolpath in WYSIWYRE

Invoke WYSIWYRE by clicking on the icon. Check the design carefully for use of
the proper tool. If the toolpath is not correct, you can experiment using different tool

widths. Use the cutter width tool .

Step 3: Selecting the material in WYSIWYRE
Select a material from the pull-down menu or by clicking an icon on the main toolbar.

Step 4: Change the fill color in WYSIWYRE

If desired, select a fill color from the pull-down menu or by clicking the  on the
main toolbar.

Step 5: Change the background color in WYSIWYRE

If desired, select a background color from the pull-down menu or by clicking the  
icon icon on the main toolbar.

Step 6: Compare multiple versions of the same job in WYSIWYRE

From the pull-down menu, choose Window > New window. Then choose Window >
Tile. You now see a duplicate job. Choose the material, fill color and background
desired for this new window.

Step 7: Save your Work!

Press Ctl-S to save the file.
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Plate Composition
Text on  curve

Long Plate

Digitizing Functions
Alignment functions

Duplication functions

Fusion-Addition-Subtraction-Offset

Segmentation functions

Convert to curve

Convert to circle

Shading

Help Functions
Group / Ungroup

Measurement tool

Upper / Lower Case

Import / Export

Import IGES-ISO (2D)

Export DFX - HPGL  (2D)

Options
Scanning / Vectorizing

Filling and 2D tool management

Braille

Drivers for competing tables

Dials and Rulers

Single & Multi-line engraver’s fonts

PhotoStyle
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There are many graphical design tools available to help create control panels. We will use a
mixture of tools in this lesson. There are as many approaches to the design process as there
are designers.

Objectives
Alignment tools
Create graphic objects
Snaps
Manual text placement
Force upper case
Manual kerning
Duplication tools
Convert text to curves
Welding tools
Digitizing tools
Envelope (distortion)

Design Specifications

Material size: 8”w by 6”h
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Creating the Design 

We will start by placing the guidelines. Then we will create the graphic elements
followed by the text. Finally, we will complete the special effects on the logo.

Step 1: Define the plate 
Open a new file and set the material dimensions to 8” by 6”. 

Step 2: Create the guidelines
Enter Manual mode. Click the cursor lock icon to allow the cursor to go outside the
material boundary. Drag the guidelines from the rulers to the positions indicated in the
specification. Use the F2 key while dragging to accurately position the guidelines.

Step 3: Create the graphical elements

Rectangles
Create the outer boundary of the panel by selecting the  icon from the Shapes
toolbox. Hit F2 for the precision dialog. Enter a width of 8”, a height of 6”, and the XY
lower left origin equals 0,0.
To create the large rounded rectangle, click the rectangle tool again and enter the
following data into the dialog at the top of the next page:To create the smaller
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rounded rectangle, click  
again, press F2 and enter a
0.125” radius, 2.2” width, .7”
height and a center origin of
4, 3.3. 

The smaller rectangle will be
placed precisely in the center
of the top line of the larger
rectangle by snapping the
center of the small rectangle
on the midpoint of the large
rectangle’s upper side. 

Open the Transformation

Toolbox and click the

Move icon . Hit F3 for
the Snaps dialog and choose the Gravity Center button. Click OK. Rest (do not click)
the cursor on the upper edge of the  small rectangle until you see a small red hint
circle in the gravity center of the small rectangle. Click and release the left mouse
button to place the origin reference of the move operation. As you move the cursor,
you see the object move with respect to its center. Hit F3 and choose Center element.
Click OK. Rest the cursor near the upper side of the larger rectangle until you see a
small red hint circle at its midpoint. Click to place.

Circles
Now we create the circles.
Click the circle icon from
the Shapes toolbox. Hit F3
and choose snap to Grid and
guideline. Move the cursor
to the 2”, 4” X, Y
intersection. When you see
that little red hint circle,
click to place the center of
the circle. You can now
visually size the circle by
moving the cursor. Click F2
and enter 0.125 for the
circle’s radius. Click OK.

Click on the Linear duplication tool icon

in the Duplication toolbox. 

Enter 5 columns and 1 row. Click OK.
Click at the guideline intersection at the
center of the circle to place the move
origin reference point. Start moving the
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cursor to the right. You see a total of 5 circles with the original anchored on the left.
We place all the circles by defining the interval between the two leftmost circles.
Move the cursor to the right until the little red hint snap circle is at the guideline
intersection of X=3.00, y=4.00. Click to place. If you have been holding the mouse
button down during this operation, then just release to place the copied circles.

Go to Select Mode and change Snap to None. 

Click in the white area to deselect the circles. Select the leftmost circle. Click on the

Duplication icon  in the Duplication toolbox. Enable Snap to Intersection. Click
in the center of the selected circle, move the cursor to the X=2.5, Y=3.25 intersection
and click to finish the copy.

Square
Click on the Create Rectangle icon on the Shapes toolbox. Place the first corner at the
2”, 2” intersection. Start dragging the cursor to the right and up a little. Hold the
Control key while dragging to force a perfect square. When the cursor snaps to the
vertical guideline at Y=3, you see a perfect 1” square. Release the mouse button to
place the square. 

This is our progress so far.

Step 4: Type and place the text
Select the Text icon to enter text mode and click to place the text marker on the
bottom guideline near the center. Guideline snaps should still be active.  Set the

baseline length to 8. Type “master control”, 0.48” high in ARIAL font.
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Select this text and click the caps icon  on the Green pinwheel to force text to
upper case. Be sure to hit Enter or click in the white work area to apply the attributes.

Click anywhere inside the small rectangle. Make character height 0.4”, X distance from
left edge equal 4” and the font US BLOCK 1L. Click in the white work area to apply.
Type “VALVE”. Place the cursor between the V and A. Press the Control Minus (on the
keypad) key combination to manually reduce the kerning. Zoom in with the right
mouse button. Repeat as necessary. Do the same for the L and V pair. You can increase
kerning with the Ctl+ key combination. Adjust up or down visually to center as
required.

Click the cursor at the 2.5, 4.5 intersection. Set the text height to 0.25”. Type “MAIN”.
Type “AUX” at location 5.5, 4.5. If the letters are too closely spaced, you’ll have to
select the letters and manually reverse the kerning. Sometimes, the kerning is
remembered for new text. 

Click at location 2.0, 4.25. Set the character height to 0.1”. Type “LEFT”. Type
“RIGHT” at 3.0, 4.25. Deselect “RIGHT” text. Hit F2 and enter 4.25”. Hit F3 and enter
4.0”. Type “MASTER” and hit Enter.

Click to place the text marker in the center of the circle at 2.50, 3.25. Type “12345”.
Choose Text on Arc from the Blue pinwheel. Enter a radius of 0.25” and hit Enter. Hit
Shift End to select this text. Change the intercharacter spacing to 200% on the Green
pinwheel. 

This is the job so far.
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Note: You can pick up certain text attributes for new text by first selecting the existing text.
Then place the text marker where you want the new text to go. It will have the same
character height, justification and font as the previously selected text.

Select the square and circle with arc text. Select the Duplication tool. Click in the
center of circle for the copy origin reference. Move the cursor to the right to location
5.5, 3.25. Click again to place the copy. Hit Escape to exit the Duplication tool.  

Select the text “LEFT” and “RIGHT”. Select the Duplication tool. Click on the
intersection between the two circles. Move the cursor to the intersection at 5.5, 4.0.
Click again to place the copy. Hit Escape to exit the Duplication tool.

Step 5: Envelope (Fit to Shape)

On the Shape toolbox, click on to enter the Symbol Library. Navigate to the
Envelope directory and choose ARC.SYB.

Place this symbol in the design and scale it down in size to roughly 1” square. Place the
envelope near the letter M. Select the text, “MASTER CONTROL” and click ‘Convert

into curves’ on the Main Toolbox .  Select the letter “M”, then add the arc
envelope to the selection by Ctl clicking it with the left mouse button. Click on the

Envelope function  from the FX toolbox. Now the letter “M” has been
distorted to fit the arc sumbol. Select just the envelope object and delete. 
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Step 6: Welding
Move the distorted ‘M’ near the ‘A’, overlapping it slightly. Zoom in to make it easier to

see. Select the letter “A” in MASTER. Click Uncombine  on the Master toolbar to
separate the parts making up the letter. Select both the outside part of the letter A and

the distorted M. click the Join icon  in the FX toolbox. 

Step 7: Final touches
Draw a thin rectangle under the words MASTER CONTROL with dimensions

approximately 7” long by 0.03” high. Open the Alignment toolbox   and select

Horizontal balancing  to center the selection horizontally. Repeat for the words
MASTER CONTROL.

Select the Digitizing toolbox . Click on the large rounded rectangle to select.
Zoom in to the intersection to the left of the V in VALUE. Hit F3 and select Snap on
intersection. Click on the intersection to the left of the V. You should see a solid red
dot. This is a placeholder for a point. Click on the ‘+’ icon to add a point here. Careful
not to inadvertently select the small rounded rectangle. If you are having difficulty
placing the dot on the proper contour, zoom in some more. Or you could use the

Snap along contour snap. Click on the Disconnect icon  to break the closed
contour. Notice that the contour color changed from blue to black. Repeat to
disconnect at the other side of the small rounded rectangle. Choose the Delete object

icon  and click on the horizontal line segment through the word “VALVE”.

Note: the blue and green contours are clockwise and counter-clockwise closed
contours respectively. Black contours are open.

Step 8: Save your work!
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Control Panel Summary

Step 1 :Define the plate 
Define a new plate 8 by 6.

Step 2 : Create the guidelines
Drag horizontal and vertical guidelines into the design into the precise positions as
specified.

Step 3: Create the graphical elements
Create an 8 by 6 rectangle for the panel border.

Create a rounded rectangle with dimensions of 6w x 3.5h x 0.25r at a center origin of
4, 3.3.

Create a rounded rectangle with dimensions of 2.2w x 0.7h x 0.125r at a center origin
of 4, 3.3.

Snap center of smaller rounded rectangle to the midpoint of the upper side of the
larger rounded rectangle.

Create a 0.125r circle at a center origin on 2, 4.

Duplicate four more identical circles to the right with 1” center to center spacing.

Create a 1” square between 2, 2 and 3, 3.

Step 4 : Type and place the text
Type “MASTER CONTROL”, center justified at 0.48” high in ARIAL font with baseline
at 4, 4.84. 

Type “VALVE” center justified at 0.4” high in US BLOCK 1L font with baseline at
Y=0.4. Manually kern letters as required with the Ctl+ and Ctl- key combinations.

Type “MAIN” center justified at 0.25” high in US BLOCK 1L font with baseline at the
2.5, 4.5.

Type “LEFT” center justified at 0.1” high in US BLOCK 1L font with baseline at the 2.0,
4.25.

Type “RIGHT” center justified at 0.1” high in US BLOCK 1L font with baseline at the
3.0, 4.25.

Type “MASTER” center justified at 0.1” high in US BLOCK 1L font with baseline at the
4.0, 4.25.

Type “12345” center justified at 0.1” high in US BLOCK 1L font with baseline at the
2.50, 3.25. Put Text on arc of 0.25” radius. Change the intercharacter spacing to 200%.

Duplicate the square and circle with arc text so that the center of the circle is placed
at 5.5, 3.25.

Duplicate the text “LEFT” and “RIGHT” so that the intersection between the two
circles beneath the text is placed at 5.5, 4.0.
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Step 5: Envelope (Fit to Shape)

From the Symbol library , select the arc envelope symbol (arc.syb). Place it near
the ‘M’ in the word MASTER and resize it to approximately 1” square. Convert the text
“MASTER CONTROL” into curves. Select the letter ‘M’ and the envelope symbol in that
order and click on the Envelope function. Delete the envelope.

Step  6: Welding
Overlap the distorted M and the A in MASTER and join.

Step  7: Final touches
Create and align a 7” by 0.03” rectangle under the words “MASTER CONTROL”. Align
“MASTER CONTROL” horizontally centered.

Cut and remove the line through “VALVE”.

Step  8: Save your work!
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NOTES:
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This tutorial will show you how to engrave a sign larger than the engrave area of your
machine. It also contains detailed instructions on the use of the mirror tools in the
Transformation toolbox.

Objectives
Define the material for a long plate operation
2D fills of text
Placing ornamental borders
Mirror copying
Setting tool properties
Setting machining properties
Panelizing the job
Engraving one or all panels
Design Specifications
File: longplate.vnd
Material Size: 24W x 6H 
Text lines 1 & 2: 1.5” character height, center justified, Arial font

Creating the Design

The design is a simple 2D filled text sign with some ornamentation. It will be designed
as a wide plate but actually engraved as a tall plate.

Step 1: Choose the Engraving Machine
For this tutorial, we will use the IS400 engraver. This will ensure activation of the long
plate mode for the size material we are using. Whenever you specify a material size
larger than the default machine area, you are prompted to either create the long plate
or allow the program to adjust the material to the default size.

If the IS400 machine is not already the default, then select or add it now. It’s OK to add
the machine to your driver list even if you don’t have one. What’s important here is to
learn how to do long plate. You can adapt these instructions to your particular table
later. The IS400 engraver can be deleted from your equipment list later.

Step 2: Define the plate size
Open a new file and set the plate size to 24”W x 6H”. Set all margins to 0.3” and click
OK. Since the width dimension is larger than can be engraved on this machine, you are
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prompted with two choices. Either the job is (1) to be engraved as a long plate or on a
cylinder or (2) the entry was incorrect and the program will adjust the material to the
default table size.

To activate long plate when you see this dialog, click No.

Step 3: Add the Text

Press F12 and set the text height to 1.5”. Select center justification and Arial text.
Enter to accept. Type “HAPPY 60th BIRTHDAY” on the first line and “NEW HERMES”
on the second line. Select the ‘th’ after ‘60’ and click on the superscript icon
superScriptIcon.bmp.

Step 4: Add Corner Ornaments
You can add corner ornaments and, in the process, learn how to use some of the other
powerful design tools available in Industry level and above. 

In most commercial Windows based design programs, there is usually more than one
way to create a design element. GravoStyle98 is no exception. This program is very
flexible, making it possible to accomplish many designs and to be able work in
different ways suitable to your individual style. For the purpose of instruction, we will
discuss adding ornaments by various methods. Pick one or go through them all as a
learning exercise.

Click on the Manual mode icon. Click Yes at the prompt. Now the two text lines are
separate text objects and additional text can be placed anywhere on the material. 
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Step 4: Add Corner Ornaments (cont’d)

1 - Using the border method:

First, we must reinstate the borders since entering manual mode automatically
eliminates them. Click on the Define Material icon and set all borders to 0.3”. At the
long plate dialog, click No.

Place the cursor anywhere in the lower left corner of the
material. From the Green pinwheel, click on the Character list

icon . This presents a chart listing all the characters in the
font whose name can be selected from the listbox located in

the lower left of the dialog. Choose
the Ornaments font from the
Gravograph folder. When you rest
the cursor over a symbol, you will
see a magnification of that symbol. Click on any lower left
corner ornament like this  Longplate3.bmpand then click
the Insert command button. (Shortcut: double-click the
font symbol to select and insert). If you do not have the
Ornament font (it is a purchased option), you can create
your own simple corner ornament. For example, create
two overlapping boxes like the figure to the right.

Go into Select mode . If the Cursor is not locked, you see this icon
cursorUnlockedIcon.bmp on the status bar. Click on it now to lock it
cursorLockedIcon.bmp. Drag the corner
ornament flush against the lower left margin.
Convert this corner ornament to curves.

Open the Transformation toolbox . While
pressing the Shift key, click on the Horizontal

mirror tool to create a mirrored copy
above the object previously selected. Control-
click on the original object so both the original
and newly created objects are selected. While
pressing the Shift key, click on the Vertical

mirror tool . Now, you have all four corner
ornaments created. Simply drag each corner ornament to its appropriate corner, fitting
each snugly against the borders.

2 - Using the align to box method:

If you performed Method 1 above, Undo until you see the four border ornaments
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touching one another as in the picture just above this sentence. Otherwise, create the
four touching border ornaments as described above. Create a rectangle object fitted to

the inside of the material border. Open the Alignment toolbox .

• Select the rectangle first then select the upper left and right corner ornaments. Click

to force the selected ornaments flush to the top of the rectangle.

• Deselect the objects. Click the rectangle and then the two rightmost ornaments.

Click to force the selected ornaments flush to the right of the rectangle. 

3 - Using the mirror copy along an axis method:

Place a lower left corner ornament as described in Method 1 above. Convert it to

curves. Select the ornament. On the Transformation toolbox  ,  click on Move
object. Hit F3 for snaps and select Control point . Click OK. Move the cursor near the
lower left corner of the ornament until you see the small red hint circle. Click once to
start moving the object. Hit F2 for the absolute point positioning dialog. Enter 0.3” in
both the X and Y boxes. Click OK. The ornament is now located precisely.

Click on the Marker tool in the Shapes toolbox. Hit F2 and enter X=12 and Y=1
to place a marker. Press F2 again, again enter 12 and 4 for X and Y. Press F2 and enter
1 and 3. And finally, press F2 and enter 4 and 3. These markers represent the axes that
will be used for mirror copying.

First, select the ornament. Then, while holding the Control key, drag a selection box
around the two vertical markers. Now, hold the Shift key. The Shift key is usually
associated with a copy operation. Click on the Mirror along axis tool
mirrorOnAxisIcon.bmp. The ornament in the lower left corner has just been copied to
the lower left corner.

Click in an unused (white) area to deselect all objects. Select the two bottom
ornaments. While holding the Control key, drag a selection box around the two
horizontal markers. Press and hold the Shift key and click on the Mirror along axis tool
mirrorOnAxisIcon.bmp. You have just copied the two left ornaments to the top. 

Delete the four markers.
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Step 5: Set Up the Job for Machining
Since we will route the letters, we must set the tool
properties in order to select 2D fill. If we were to only
route the outlines, we could proceed directly to the
Machining dialog. So for 2D fill, click on the Tool Color
properties icon toolColorIcon.bmp so we can set the
tool properties. This job uses the default Tool 0 assigned
to the black color. Click on the Properties button on the
Tool Properties dialog.

Select ‘2D on surface’ from the pull-down menu in the
next Tool Properties dialog. The depth should be set to
0.008” if you are using the nose cone. This is because
the standard engraving tools defined in the provided
tool library have their tip sizes defined at 0.008” up from
the bottom of the tool. By choosing this depth, the

program will calculate
accurate toolpath. Choose
Island or Hatch fill and the
desired overlap and
hatching angle if using
hatch fill. You must assign a
tool to the color black.
Knowing the geometry of
the tool, the software will
accurately calculate the 2D
fill. Simply select the color

first, and then double-click on the tool in the ‘Available tools’ window. You see the
numeric values of the tool parameters in the gray boxes above the ‘Available tools’
window. This tool/color association is stored with this job.

Click on the Machining (Mecanisation) tab. The black tool (Tool 0) should still be
selected on the right.
The tool’s specific
machining properties
are set in this dialog;
speeds, spindle enable,
tool pause, etc.

Select the X,Y, and Z
speeds by clicking on

the speed-o-meter .
Each time it is clicked,
the red speed indicator
moves to the next speed
- low, mid, high. One more click cycles back to low to start the sequence again.
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Holding the cursor over the meter, pops up the actual speed value. You can over-ride
the default speeds by clicking on the rabbit icon and entering your own values. The
text box under the meters is the engraving depth for this tool. The button under the
depth is the dwell time. Using this is optional depending on the material used. The
dwell time is the time the spindle remains motionless after a plunge into the material
before moving inside the material.

The spindle icon on the right should be enabled since we are using a rotary cutter. The
other icons below the spindle icon should be disabled (X’ed). Click OK when done.

Click on the Machining icon . This invokes the Long plate definition dialog.

Notice that the job is split into three panels by the dashed red lines. These panels are
defined starting from the bottom. The program splits the design at the maximum
vertical dimension of the engraving machine. You are able to manually move the cut
lines to avoid cutting through objects. It is much easier to get a better quality job if the
cut line does not break an object. However, if you have a large graphic object, you may
have to split the object onto two or more panels.

Notice also, that the job is presented with 2D filled letters. If the plotting option were
selected, you would see just the outline of the letters (as shown below).

There are two ways to move a cut line. You can control the line from the left red dot
or the right red dot. The left red dot allows you define a zigzag line while the right dot
moves the whole line up or down.

You can zoom as you would in the design screen using the icons under the caption bar
or with the right mouse button. Click the right mouse button to zoom in (magnify) or 
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Step 5: Set Up the Job for Machining (cont’d)
Control-click the right mouse button to zoom out (shrink) the view. Before clicking to
zoom, place the cursor in the center of the zoom area.

To control a zigzag line, hold the cursor over
the left red dot until the cursor arrow changes
to a pencil. Click once on the left red dot.
You’ll want to use the zoom feature to facilitate
placing the cut line in narrow spaces.

You can now move the red dot down to set the
start point of the cut. You are prevented from
moving the start point upward due to the
limitation of the engraving area. Click once to
place the start point (A). You are free to move
the next
point.

Click to place the next point (B). Continue
placing points as required. To finish, click in
the gray area on the right side.

To move the entire line up or
down, place the cursor over
the right red dot. Click once to free the line. Move the line up or
down as required. Click once more to place the line. 

You can repeat this process as many times as you need to on any line.
As the lines are moved down, a new panel may be automatically
added at the top.

When you are satisfied with the cut lines, click OK. The Machining
dialog is presented.

Notice that the vertical orientation “ABC” icon has been automatically
selected to engrave the job vertically. Select the XY speed, Z speed,
depth, dwell time
and Z-lift if not
already selected. For
further discussion
on setting these
parameters, refer the

Tool Management by Color tutorial.
Since you do not need the engraver to
prompt you for the tool (only one
tool used), click off the tool prompt
command buttons. There is the
Global tool pause command button
allToolpromptCmd.bmpand and the
individual tool pause command
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button  singleToolpromptCmd.bmp that can be
deselected.

If you click on the ‘Toolpath Select’ button, you
see four toolpaths defined; one for each panel. If
you need to re-engrave a single panel after the
job is engraved, this is the dialog where you
select only the panel to be engraved. The job is
engraved in toolpath order, from top to bottom
in this list. 

The correlation between the toolpath name
and the actual sign is shown at left

You have the opportunity to change the speeds and depth on the Machining dialog if
you wish.

Click OK to keep the machining job parameters that you have set in this dialog. This is
useful, for example, if you need to leave this dialog and return to it later without first
engraving the job.

Click Run to send the job to the engraver.

Click Cancel to exit this dialog.

Click Spooler to invoke the Windows spooler dialog where you can pause or delete
jobs that Windows is processing for output to the engraver.

Tool 0(1)Pan3

Tool 0(1)Pan2

Tool 0(1)Pan1

Tool 0(1)
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Step 6: Engrave the Job 
Put the tool in the spindle and set the Z-reference. Position the work piece in the

lower left corner of the machine with the long end of the material sticking out
the back. When the engraver is ‘Ready to Receive’, click Run on the Machining
dialog to send the job to the engraver. 

When the first panel is finished, a message on the pendant’s LCD panel
prompts you to move the panel a certain amount in the Y (up) axis. This is
towards the front. Follow the prompts and press start for each panel. 

Step 7: Save your Work
Press Control-S to save the file.

Engraving Tip

You can start engraving on the IS400
while it is receiving data by pressing
the Start button on the pendant. You
can increase and decrease the
speed of the IS400 while it is
engraving by pressing the up (or
right) and down (or left) arrows on
the pendant.
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Sign With Long Plate Option Summary

Step 1: Choose the Engraving Machine
We will use the IS400 engraver for this tutorial.

Step 2: Define the plate size
Open a file and set plate size to 24”W x 6H”. Set all borders to 0.3”. At the prompt,
select No for long plate mode.

Step 3: Add the Text
Set the text height to 1.5”. Select center justification and Arial text. Type “HAPPY 60th
BIRTHDAY” on the first line and “NEW HERMES” on the second line. Select the ‘th’
after ‘60’ and click on the superscript icon superScriptIcon.bmp.

Step 4: Add Corner Ornaments
Enter Manual mode. Place the cursor anywhere in the lower
left corner of the material. From the Green pinwheel, click

on the Character list icon . Choose the Ornaments font
from the Gravograph folder. Click on any lower left corner
ornament like the figure at right, and then click the Insert
command button. If you do not have the Ornament font, you

can create your own simple corner
ornament. For example, create two overlapping boxes like
the ones in the figure at left.

Go into Select mode . If the Cursor is not locked, lock it.
Drag the corner ornament flush against the lower left margin. 

Open the Transformation toolbox . While
pressing the Shift key, click on the Horizontal mirror

tool . This creates a mirrored copy above the
object previously selected. Control-click on the
original object so both the original and newly
created objects are selected. While pressing the Shift

key, click on the Vertical mirror tool . Now, you
have all four corners created. 
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Step 4: Add Corner Ornaments (cont’d)
Simply drag each corner ornament to its appropriate corner, fitting each snugly against
the borders.

Step 5: Set Up the Job for Machining

Click on the Tool properties icon so we can set the tool properties. This job uses
the default Tool 0 assigned to the black color. Click on the Properties button on the
Tool Properties dialog.

Select ‘2D on surface’ from the pull-down menu in the next Tool Properties dialog.
The depth should be set to 0.008” if you are using the nose cone. Choose Island or
Hatch fill and the desired overlap and hatching angle if using hatch fill. You must
assign a tool to the color black. Simply select the color first, and then click on the tool
in the ‘Available tools’ window. This tool/color association is stored with this job.

Click on the Machining tab. The black tool (Tool 0) should still be selected on the
right. The tool’s specific machining properties are set in this dialog; speeds, spindle
enable, tool pause, etc.

Select the XY and Z speeds by clicking on the speed-o-meter toolMeterButton.bmp.
One more click cycles back to low to start the sequence again. You can over-ride the
default speeds by clicking on the rabbit icon and entering your own values.

The spindle icon on the right should be enabled since we are using a rotary cutter. The
other icons below the spindle icon should be disabled (X’ed). Click OK when done.

Click on the Machining icon . This invokes the Long plate definition dialog.

Now, define the cuts for panelizing the job. To control a zigzag line, hold the cursor
over the left red dot until the cursor arrow changes to a pencil. Click once on the left
red dot. You’ll want to use the zoom feature to facilitate placing the cut line in narrow
spaces.

You can move the red dot down to set the start point of the cut. Click once to place
the start point. You are free to move the next point. Click to place the next point.
Continue placing points as required. To finish, click in the gray area on the right side.

To move the entire line up or down, place the cursor over the right red dot. Click
once to free the line. Move the line up or down as required. Click once more to place
the line. 

Repeat this process as many times as you need to on any line. As the lines are moved
down, a new panel may be automatically added at the top.

When you are satisfied with the cut lines, click OK. The Machining dialog is presented.

Select the XY speed, Z speed, depth, dwell time and Z-lift.

Click Run to send the job to the engraver.
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Step 6: Engrave the Job 
Put the tool in the spindle and set the Z-reference. Position the work piece in the
lower left corner of the machine. When the engraver is ‘Ready to Receive’, click Run
on the Machining dialog to send the job to the engraver. 

When the first panel is finished, a message on the pendant’s LCD panel prompts you to
move the panel a certain amount in the Y (up) axis. Follow the prompts and press start
for each panel. 

Step 7: Save your Work
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LESSON # -----   PhotoArt

   This lesson shows how to create a 3D surface from a grayscale picture that has been scanned
into a bitmap image.

Objectives:
How to set the parameters to create the 3D image.
The steps to use to create a tool path from the GravoStyle 98 software.

Design specifications:
A butterboard sample size: 2 7/8” by 3 7/8” by 1” thick.
The bitmap image  Ceaser2.bmp
A gravoply cutter # 42007005

STEP # 1:  Start a new job

A. Set the material size to:        2.875 inch  wide
3.875 inch high
0 inch margins ( all )

STEP # 2:  Import A bitmap and Scale it

A. Enter the selection mode by clicking on the Selection button

B. Import the bitmap Ceaser2.

C. Scale the bitmap image from the center to a width of  2.75”

How to !   Press the shift key and keep it depressed while clicking on a corner of
the bitmap image and without releasing either press the F2 key, now the shift key
and the mouse button can be released. Now enter 2.75 into the width window
and press the Enter key.

D. If the bitmap is not selected, select it now.
     How to !   Position the cursor pointer on one of the edges of the bitmap and
press the left mouse button only one time. Caution !!!!  Double clicking the edge
of the bitmap will open the bitmap editor, which we don’t want to do.

D. Save the file.

STEP # 3:  Start  Styl-Art and create a 3D surface.

A. Press the Styl’Art button on the top tool bar

B. Set the dark elevation to -.060”

C. Set the Bright elevation to -.005”

D. Press the enter button to close this window and generate the 3D surface.
NOTE !  It is not necessary to to select any of the other buttons as the
software defaults to the Replace mode.
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STEP # 4:  View the surface and smooth the surface details

A.  Click the Fast View button to view the 3D surface

NOTE !  By positioning the mouse cursor in the right hand window and left click
and drag the image can be rotated and tilted for various viewing angles. Right
clicking and drag will cause the image to be zoomed in or out.

B. Now to smooth out the roughness of the surface.
1. Exit this window by selecting from the top menu FILE, then QUIT

C. To smooth the entire image click the MEAN FILTER button

1. Enter the number of times you want the image to be smoothed  (use 4 times)
2. Press the Enter key to accept this number and do the smoothing operations.
3. To view this smoothed image again repeat STEP # 4 A & B

STEP # 5:   Enter the tooling information and create the tool path.

A. Click the tool management button to open the tool selection options.

B. Select the following buttons in this order;
Selection, Closed contours, then the SEND button to open the tool path creation
window.

C. In order to view the image the view must be changed to an isometric view.
HOW TO !   At the top menu choose  the view option and scroll down to the
3D ISO View option.
NOTE !!!   When this window is opened the view is from straight above the part
and no z information will be visible.

D. At this point we have to select the type of tool path.
1. At the top menu select the TOOL PATH option
2. Scroll down to the TypeArt option to open the tool definition

window

E. Select the tool 42007005 Grply 005 30’ in the TOOL NAME window.
1. In the allowance window enter 0.000
2. In the Stepover window enter .004
3. Set the sweep angle to 000  ( might read Hatch angle )
4. Set the Mode to Sweep ( might be Hatch )
5. Click the tools Database button so that you can set some tool

parameters.
6. Click the Plus icon to open the tool parameter window
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7. In the FEED RATE portion of the window you will make two entries.
a. Set the nominal speed to .25” /sec.
b. Set the plunge feedrate to .2” / sec.

     No other changes or entries are needed in the  window.
NOTE !!!!  On some machines the XY or Z  axis will stall because of high
rapid feedrates resulting in loss of position. This can cause goughing or
crashes. The feedrates recommended above will be safe for most
attempts.

8. Close this window.

9.    Click the save button to save the changes that were made in the
       previous window, then click the OK button to close this window.

9. Close the TypeArt milling window to start the tool path generation
process.   Watch it build the tool path first in white then in yellow.
When the yellow is finished the information is ready to be sent to the
machining module.

STEP # 6:   Setup the job for the machine and send it to the machine

A. Click the machine icon to set up the  orientation and position

B. Select the machine that the job will be sent to.

C. Select the orientation of the job

D. Set the spindle to run with the job.

E. Select the vise as the work position that will hold the work piece.

F. Set the Z clearance to .075

G. The Z depth should be set to 0.00 because we are machining to a surface.

H. OK !  OK ! Now click the run button to send the job to the machine.
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STEP #7: Set up the tooling on the machine and run the job.

A. Set the tip of the tool to the surface and use this point as Z Ref.

B.  Start the job and enjoy. It will take a while to cut this piece.
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Text Toolbox 
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Yellow Pinwheel Text Toolbox
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Blue Pinwheel Text Toolbox
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Special Effects Toolbox 
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Wrapping Tools  
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Hot Keys
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F1 Help

F2 Precision dialog

F3 Snaps

F4 Preview

F10 Options

Ctl-1 XY View

Ctl-2 YZ View

Ctl-3 XZ View

Ctl-4 Engrave View

Ctl-5 ISO View

Ctl-6 3D dialog

Ctl-A Redo last operation

Ctl-C Copy selection to clipboard

Ctl-L Select All objects in select mode

Ctl-M Open model file

Ctl-N New file

Ctl-O Open file

Ctl-R Fast redraw

Ctl-S Save file

Ctl-V Paste selection from clipboard

Ctl-W Redraw

Ctl-X Cut selection to clipboard

Ctl-Z Undo last operation

Del Delete selection
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